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Hinweise zu diesem Handbuch 

Mit diesem Handbuch erhalten Sie Hinweise und Informationen über die Funktion und Konfigura-
tion des LSS MasterGate.  

 

Dieses Handbuch gilt für den LSS MasterGate. Wie alle anderen Produkte aus dem Hause LSS 
GmbH unterliegt der LSS MasterGate einer ständigen technischen Weiterentwicklung. Deshalb 
werden hier unter Umständen Funktionen und Einstellungen beschrieben, die für den von Ihnen 
genutzten LSS MasterGate nicht verfügbar sind. 

Dieses Handbuch nutzt folgende Symbole, um für Sie wichtige Hinweise zu Ihrer Sicherheit und zur 
Konfiguration kenntlich zu machen. 

 

 
Hier erhalten Sie zusätzliche Informationen 

  

 

Achtung weist Sie auf Situationen hin, in denen Entscheidungen zu technischen Prob-
lemen mit dem Gerät oder zu Datenverlusten führen können. 

  

 

Eine Warnung bezeichnet Situationen, in denen Verletzungen oder Schäden für Leib 
und Leben auftreten können. 

 

 

Sicherheitshinweise 

Der Umgang mit dem LSS MasterGate ist nicht gefährlich. Schutzisolierung und weitere Sicher-
heitsmaßnahmen verhindern zuverlässig, dass Sie mit gesundheitsschädlichen Spannungen und 
Strömen in Berührung kommen. Beachten Sie aber folgende Hinweise: 

 

 

 Nehmen Sie niemals sichtbar beschädigte Geräte in Betrieb! 

 Liegt der Verdacht auf einen Defekt vor, trennen Sie das Gerät sofort von der 
Stromversorgung! Sichern Sie das Gerät gegen Wiederinbetriebnahme! 

 Öffnen Sie niemals das Gerät! Wenn Sie das Gerät öffnen besteht Lebensgefahr!  

 Berühren Sie niemals eine der intern verbauten Komponenten!  

 Reparaturen dürfen nur von Mitarbeitern der LSS GmbH durchgeführt werden. 
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Hinweise zur Handhabung 

Das LSS MasterGate ist für einen Dauerbetrieb konzipiert. Dennoch sollten Sie folgendes beachten: 

 

 

 Setzen Sie das Gerät nur zu seinem bestimmungsgemäßen Zweck ein! 

 Vermeiden Sie extreme mechanische Belastungen! 

 Vermeiden Sie jegliche mechanische Einwirkungen auf das Display! 

 Vermeiden Sie direkte Nässeeinwirkung sowie übermäßige Hitzeeinwirkung auf 
das Gerät! 

 Montieren Sie das Gerät nicht unmittelbar über Scheinwerfern! 

 

Wir freuen uns über Ihre Hinweise und Kommentare zu diesem Handbuch. Bitte senden Sie diese 
per E-Mail an mail@lss-lighting.de. 

 
 
 

History 

 

Firmware Änderung 

1.02 Erstauslieferung 
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Das MasterGate 
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Leistungsumfang 

Das LSS MasterGate ist ein Gateway, Konverter und Speicher für Daten in Theater-, Studio-und 
Veranstaltungsnetzwerken. Innerhalb eines Datennetzwerkes ist es die Verbindung zwischen 
Ethernet, DMX und Profibus-DP. Das MasterGate kann Daten aus, in und innerhalb dieser Netz-
werke routen, mergen, oder wandeln. Es kann dabei nicht nur die üblichen Protokolle eines 
Lichtnetzwerkes verarbeiten, sondern auch die des Nexus-Systems von Salzbrenner Stagetec®.  

 

Für eine umfassende Gerätekonfiguration und -überwachung unterstützt das LSS MasterGate das 
Remote Device Management (RDM). Ebenfalls können die Datenströme innerhalb des Lichtnetz-
werkes auf Monitoren in Echtzeit überwacht werden. Zur Überwachung von Einzelereignissen sind 
Verify-Funktionen zuschaltbar.  

 

Im LSS MasterGate können bis zu 32 Datensätze, wie z.B. Lichtstimmungen oder Audiofiles, in ei-
nem Registerspeicher abgelegt und auch wieder abgerufen werden. Für Lichtstimmungen sind in-
dividuelle Ein- und Ausblendzeiten und sogar Dimmerwerte einstellbar. Im Zusammenspiel mit ei-
nem Digitalen Nebenpult und einer Steuerung können so Arbeitslichter, Blaulichter, Probenlichter 
und sogar Lichtstimmungen für Zuschauerbereiche in einer Nebenanlage eingestellt und abgeru-
fen werden.  

 

Das LSS MasterGate ist mit acht voneinander unabhängigen DMX-Anschlüsse ausgestattet, die so-
wohl als DMX-Eingänge als auch DMX-Ausgänge definiert werden können. Zwei Anschlüsse sind 
mit DMX-Thrus und schaltbarer Anschlussterminierung ausgestattet. Zusätzlich verfügt es über 
Ethernet und Profibus-DP-Anschlüsse sowie einem Anschluss für optionale DMX-Filter.   
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Funktionsübersicht 

DMX 

Anschlüsse 

Der LSS MasterGate verfügt über acht frei als In oder Out definierbare DMX-Anschlüsse. In der 
XLR-Version sind die Anschlüsse eins bis sechs als Female und die Anschlüsse sieben und acht als 
Male ausgeführt, verfügen über eine zuschaltbare Terminierung und haben einen DMX-THRU zu-
geordnet. 

 

Parameter für DMX-Out definierte Anschlüsse 

Sind die Anschlüsse als DMX-Ausgänge definiert, können für jeden Anschluss folgende Parameter 
eingestellt werden: 

 

 Timeout-Zeiten oder Halten des letzten Protokolls 

 Empfangs-Universe 

 Merge-Modus 

 Sende-Universe mit Angabe der Priorität 

 DMX-Startcode und Protokolllänge 

 Breaklänge 

 Mark After Break 

 Mark Before Break 

 Mark Between Slots 

 

 

 

Ethernet 

Licht-Netzwerkprotokolle 

Das LSS MasterGate unterstützt folgende Licht-Netzwerkprotokolle: 

 

 sACN 

 Art-Net 

 ShowNet 

 AVAB/UDP 

 AVAB/IPX 

 

Das Standard-Netzwerkprotokoll des LSS MasterGates bei Auslieferung ist sACN.  

  



LSS MasterGate 

 
LSS 13 

 

 

 

Netzwerkeinstellungen 

Folgende Parameter sind einstellbar: 

 

 separate Einstellung von Licht-Sende- und Empfangsprotokoll 

 Verhalten bei Ausfall der letzten Empfangsquelle (Timeout, Hold) 

 Licht-Senderate (bei Leerlauf ohne Datenänderung) 

 IP-Adresse  Manuell / Art-Net 2.x.x.x / Art-Net 10.x.x.x / DHCP 

 IP-Subnetz-Maske 

 Gateway-IP 

 SLP Netzwerkprotokoll nach RFC2608 (SLP V2) 

 RDM-Net Netzwerkprotokoll nach ANSI 1.37 

 Einschaltung der Sende- und Empfangschecksummenprüfung 

 Einstellung der Ethernet-Geschwindigkeit und des Duplex-Mode 

 
 

Profibus 

Das LSS MasterGate besitzt eine flexible Parametrierung von Profibus-Dateien. Empfangene Profi-
bus-Daten können mit Daten aus anderen Quellen gemergt und gemergte Daten können in den 
Profibus gesendet werden.  

 

Stimmungsspeicher 

Das LSS ist mit einem Speicher für bis zu 32 Lichtstimmungen ausgestattet, über Profibus oder 
DMX-In angesprochen und gesteuert werden können. 

 

 

Merge-Verhalten 

Das LSS MasterGate kann bei Anlagen, die auf dem gleichen Subnetz/Universe im Ethernet sen-
den, bis zu 4 Datenquellen HTP-mergen. Es werden ebenfalls Prioritäten unterstützt, wenn dies 
das Lichtprotokoll zulässt.  
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Remotekonfiguration 

Für alle LSS-Geräte wird die kostenlose Software ConfigCore empfohlen, die alle Features des LSS 
MasterGate und anderer LSS-Geräte, aber auch Art-Net-Geräte anderer Hersteller unterstützt. Nur 
mit dieser Software ist es möglich, alle Geräte im Netzwerk aufzufinden und das LSS MasterGate 
komplett remote zu konfigurieren. 

 

Als Art-Net-kompatibles Gerät arbeitet der LSS MasterGate problemlos mit Art-Net-Softwaretools 
anderer Hersteller, wie z.B. dem Programm DMX-Workshop zusammen (Download unter 
www.artisticlicence.com). Selbstverständlich hat der LSS MasterGate wie alle anderen ArtNet-
Geräte eine eigene OEM-ID (ab Workshop-Version 3.57 erkannt und unterstützt). Über dieses Tool 
ist auch eine eingeschränkte Remote-Konfiguration möglich. Beachten Sie, dass Art-Net hier nur 
eine Untermenge des LSS MasterGate konfigurieren kann.  

 

Auch bei anderen eingestellten Licht-Protokollen als ArtNet ist der LSS MasterGate mit 
ConfigCore immer konfigurierbar, es wird lediglich vorausgesetzt, dass der PC im IP-
Adressbereich das LSS MasterGate liegt. 
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Anzeige-, Anschluss- und Bedien-
elemente 
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Geräteüberblick 

Frontseite 

Menübildschirm 

 

Freidefinierbare  

DMX-Anschlüsse 

 
 

Betriebsanzeigen 

und Taster 

 

Ethernet 

Anschluss 

 

Dreh/Drück- 

Encoder 

 

DMX-Anschlüsse 

Der LSS MasterGate kann mit DMX-Anschlüsse im 5polig XLR oder RJ45-Design ausgestattet wer-
den. Die Anschlüsse sind in der Menüsteuerung als Ein- oder Ausgänge frei definierbar. Oberhalb 
der Anschlüsse wird der Betriebszustand mit LEDs angezeigt: 

 

LED Farbe Bedeutung 

Anschluss als 
DMX-In defi-
niert 

Gelb Ein: Datenempfang 

Flackern: RDM ist aktiv 

Blinkt: dauerhaft fehlerhaftes Protokoll 

Aus: keine Datenempfang 

Anschluss als 
DMX-Out de-
finiert 

Gelb Ein: Daten werden gesendet 

Flackern: Hold aktiv  – kein Empfang von Daten, letzte empfangene 
Daten werden weiter gesendet 

Blinkt: RDM aktiv 

Aus: DMX-Out ist abgeschaltet 
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Ethernet Anschluss 

Oberhalb des Ethernet-Anschlusses wird der Betriebszustand mit LEDs angezeigt: 

 

LED Farbe Bedeutung 

Speed Grün Ein: Es besteht eine Datenverbindung mit 100MBit/s. 

Aus: In Verbindung mit Link-LED 

Link Gelb Ein:  Es besteht eine Datenverbindung. Ist die Speed-LED gleich-
zeitig aus, besteht eine Datenverbindung von 10MBit/s. 

Flackern: Daten werden übertragen. 

Aus: Sind Link- und Speed-LEDs aus, besteht keine Ethernet-
Verbindung. 

 

Betriebsanzeigen 

Über die LEDs an der Frontseite werden die Betriebszustände des LSS MasterGate angezeigt. 

 

LED Farbe Bedeutung 

Power blau Ein: Betriebsspannung vorhanden 

Aus: Betriebsspannung nicht vorhanden 

ACTIVE/FAIL  Grün Flackern: Es liegen aktive UND gerouteten Netzwerk -Universen an 
(egal ob Empfang oder Senden) 

Ein: DMX-Ports  

Blinkt: Gerät wird über ConfigCore oder RDM identifiziert 

Aus: Alle DMX-Anschlüsse sind aus 

Orange Blinkt: Warnmeldung 
Gerätetemperatur ist höher als 75°C 

Rot Nur Fehlermeldungen 

Flackert: Nur beim Start – keine Fehlermeldung 

Blinkt: Gerätetemperatur ist höher als 80°C - Akustisches Warn-
signal ertönt 
Lüfter prüfen und Gerät ausschalten! 

An: Sammelfehler – Service informieren! 

 

Im Gerät sind noch weitere Diagnose-LEDs vorhanden. Diese sind für Service und Wartung vorge-
sehen. 
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Taster 

Auf der Frontseite des LSS MasterGate befindet sich ein Reset- Taster, mit dem das Gerät neu ge-
startet werden kann. 

 

Taste Rückmeldung Bedeutung 

Reset keine Neustart des LSS MasterGate 

 

 

Rückseite 

 
 

 Spannungs-
versorgung 

Gerätesi-
cherung 

 Profibus-DP Datenträger optionale 
DMX-Filter 

 

 

Spannungsversorgung und Gerätesicherung 

Die Spannungsversorgung erfolgt über Kaltgeräteanschluss (IEC 60320-C14) auf der Rückseite. 
Oberhalb des Anschluss ist die Gerätesicherung.  

 

Sicherungstyp:  Schmelzsicherung 1,6A T 

 

Datenträger  

Auf dem Datenträger befinden sich das Betriebssystem und alle gespeicherten Daten. Er kann im 
Falle eines Gerätetausches kann der Datenträger aus dem Slot herausgenommen und in ein Er-
satzgerät eingeschoben werden. 

 

 

Der Datenträger darf unter keinen Umständen aus dem Gerät entnommen werden, 
wenn es noch eingeschaltet ist! 
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Konfiguration des LSS MasterGate 
am Gerät 
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Hinweise zur Bedienung des Menüs 

Aufbau 

Die Menüstruktur des LSS LSS MasterGate ist hierarchisch angeordnet. Die erste Ebene ist die Be-
triebsanzeige, von der der Zugriff auf das Hauptmenü erfolgt. Vom Hauptmenü sind die weiteren 
Untermenüs thematisch in Ebenen unterteilt. 

 

Menüauswahl 

Drehen am Encoder wählt die unterschiedlichen Menüpunkte und Schaltflächen. Das markierte 
Menü oder die Schaltfläche wird  invers  dargestellt. Kurzes Drücken auf den Encoder markiert 
diesen Menüpunkt oder die Schaltfläche als ausgewählt. 

 

Einstellungen vornehmen und speichern 

Der ausgewählte Parameter wird  invers blinkend  dargestellt und kann nun durch Drehen am En-
coder verändert werden. Erneutes Drücken übernimmt die Einstellung, die veränderten Parameter 
werden dann sofort wirksam. 

 

Das Betätigen der Schaltfläche „Cancel“ führt das LSS MasterGate in das vorhergehende Menü zu-
rück, geänderte Werte werden nicht gespeichert, auch wenn sie bereits temporär eingestellt wa-
ren. 

 

Das Betätigen der Schaltfläche „Ok“ speichert die geänderten Werte dauerhaft.  

 

Wenn der Encoder längere Zeit nicht betätigt wird, geht das LSS MasterGate automatisch in die 
Betriebsanzeigezurück. Dabei wird das Gerät wieder gegen unbefugte Bedienung verriegelt und 
das eingegebene Passwort gelöscht. Nicht gespeicherte Änderungen im aktuellen Menü gehen 
verloren. Der Timeout kann im Bildschirmschoner-Menü eingestellt werden (Default 30s). 

Dieser Timeout ist in den Monitor-Modi unwirksam, damit auch längere Beobachtungen möglich 
sind. 

 

 

Bitte beachten Sie, dass jede Änderung der Einstellungen weitreichende Folgen auf 
Ihre Lichtanlage haben kann. Die folgend beschriebenen Einstellungsmöglichkeiten 
setzen auch voraus, dass Sie Erfahrungen und Kenntnisse in der Konfiguration von 
DMX und von Ethernet-Lichtprotokollen besitzen.  

 

  



LSS MasterGate 

 
LSS 21 

 

 

 

Betriebsanzeige 

In derBetriebsanzeige werden im Display für einen ersten Überblick verschiedene Monitor ange-
zeigt. 

 

 

 

Version 

DMX-Monitor  

Lichtprotokoll  

Ethernet Profibus 

  

 

Ein ausgefüllter Kreis bedeutet „Zustand aktiv“, ein nicht ausgefüllter Kreis bedeutet „Zustand 
nicht aktiv“, blinkend bedeutet „Fehler“. 

 

 

Version 

In der Betriebsanzeige werden zwei Informationen angezeigt. Links wird die aktuell verwendete 
Firmware-Version angezeigt. Rechts steht der ArtNet-Kurzname, mit dem das LSS MasterGate im 
Netzwerk zu finden ist. 

 

DMX-Monitor 

Der DMX-Monitor gibt einen allgemeinen Überblick über die Situation an den DMX-Anschlüssen. 
Links sind dabei die DMX-In und rechts die DMX-Out angeordnet. Die DMX-THRU werden nicht an-
gezeigt. 

 

DMX-In 

Anzeige Bedeutung 

Act An dem DMX-Eingang wird ein korrektes DMX-Protokoll empfangen. 

Act (blinkt) Das DMX-Protokoll an dem Eingang ist ungültig (Startcode oder Timing). 

Flt Das DMX-Filter ist eingeschaltet und für diesen IN aktiv. 
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DMX-Out 

Anzeige Bedeutung 

Act Der DMX-Ausgang ist aktiv und sendet. 

Mrg Die DMX-Daten am Ausgang entstehen durch Mergen von mindestens 2 Quellen 
im Routing (DMX / Ethernet / Profibus / Stimmungsspeicher). 

Flt Das DMX-Filter ist eingeschaltet und für diesen Out aktiv. 

 

Lichtprotokoll-Monitor 

Wie beim DMX-Monitor sind links die eigehenden und rechts die ausgehenden Daten angeordnet. 
Wenn der Empfang und das Senden der Daten mit dem gleichen Protokoll realisiert wird, steht 
dieses in der Mitte. Sonst stehen beide Protokolle über den IN- bzw. OUT-Spalten.  

 

Ethernet-In 

Anzeige Bedeutung 

Act Auf diesem Socket ist mindestens 1 Sender aktiv. 

Mrg Auf diesem Socket ist mehr als 1 Sender aktiv. 

Sub In Routing eingestelltes Subnet, auf dem empfangen wird. 

Uni In Routing eingestelltes Universe, auf dem empfangen wird. 

 

Ethernet-Out 

Anzeige Bedeutung 

Act Dieser Mergepuffer wird über Ethernet als Universe gesendet. 

Mrg Dieser Mergepuffer hat mindestens eine aktive Quelle. 

Sub Im Ethernet-Send-Routing eingestelltes Subnet, auf dem gesendet wird. 

Uni Im Ethernet-Send-Routing eingestelltes Universe, auf dem gesendet wird. 

 

Ethernet-Monitor 

Dieser Monitor gibt einen Überblick über die Einstellungen des Ethernets. Dazu werden eventuell 
angekoppelte Nebenpulte oder Verbindungen zum Nexus-System angezeigt.  

 

Netzwerk 

Anzeige Bedeutung 

IP Eigene IP-Adresse. 

Lnk, Data Ethernet-LEDs Linkstatus, Daten 
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Meldungen zu Nebenpultkopplung und Nexus-Verbindung 

Anzeige Bedeutung 

Rem Remote-IP-Adresse der Nebenpultkopplung. 

Nxs IP-Adresse des Nexus-Systems 

Disabled Keine Nebenpult-Kopplung verwendet. 

Searching... LSS MasterGate sucht nach Remote-IP des Nebenpultes 

Remote IP not found Nebenpult nicht gefunden 

Remote host found       * Nebenpult wurde gefunden, sendet aber nicht 

Up and running             * Datenaustausch mit Nebenpult über Ethernet läuft 

Nexus running Datenaustausch mit Nexus-System läuft 

(*) In diesen beiden Zuständen erscheint rechts ein drehendes Symbol, das die Versuche zur Kontakt-
aufnahme des LSS MasterGate bzw. den Datenaustausch anzeigt. 

 

Meldungen bei TFTP-Verbindungen 

Anzeige Bedeutung 

Put: <Da-
teiname> 

Datei wurde mit TFTP empfangen und gespeichert 

Get: <Da-
teiname> 

Datei wurde mit TFTP gesendet 

 
Meldungen zur Netzwergeschwindigkeit 

Anzeige Bedeutung 

10Auto/ 

100Auto 

Automatische Geschwindigkeitsermittlung 

10 oder 100MBit/s 

10/100/ 

Hdx/Fdx 

Manuelle Geschwindigkeit  

10 oder 100 MBit/s, Hdx=halb duplex, Fdx=full duplex 

 
 

Profibus-Monitor 

Der Profibus-Monitor zeigt die Aktivitäten am Profibus-Anschluss an. 

 

Meldung zu Profibus-Verbindung 

Anzeige Bedeutung 

Address Profibus-Adresse. 

WtDog Profibus-Ansprechüberwachungszeit in Millisekunden oder „off“. 
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Meldungen über Zustand der Profibus-Verbindung 

Anzeige Bedeutung 

Init Error Profibus-Hardware nicht erkannt, Gerät wahrscheinlich defekt 

Bus Error Kein Profibus-Master vorhanden 

Param Error Parametrierfehler im Profibus-Master 

Config Error Konfigurierfehler im Profibus-Master 

Baudrate 
Fnd 

Profibus-Master vorhanden, aber kein Datenaustausch, mglw. falsche Adresse ein-
gestellt oder falsche GSD-Datei 

Data 
Exchange 

Datenaustausch läuft 

 

 

Passworteingabe 

Vor dem Einstieg ins Hauptmenü muss ein Passwort eingegeben werden. 

 

 
 

Dabei „merkt“ sich das LSS MasterGate das zuletzt eingegebene Passwort so lange, bis es entwe-
der ausgeschaltet, rückgesetzt oder in der Passworteingabe bzw. im Password-Menü die Schaltflä-
che „Clear“ betätigt wird. 

 

 

Auswahl Bedeutung 

****** Eingabe der Buchstaben des Passwortes durch Drücken, Drehen und wieder Drü-
cken 

Clear Passwort löschen 

Ok Das Passwort wird überprüft. Bei korrekter Eingabe Aufruf des Hauptmenüs, sonst 
zurück in die Betriebsanzeige 
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Einstellungen im Menü 

Menüstruktur 

Ebene 1 Ebene 2 Ebene 3 Ebene 4 Bedeutung 

View DMX DMX-In 
1…8 

Mode, Verify, Range Darstellung DMX-Eingangswerte (grafisch, prozentual, he-
xadezimal), Verify-Funktion 

DMX-
Out 1…8 

Mode, Verify, Range Darstellung DMX-Ausgangswerte (grafisch, prozentual, he-
xadezimal), Verify-Funktion 

RDM In 1…8 Für kommende Anwendungen 

Out 1…8 Für kommende Anwendungen 

Ether-
net 

In-
Univer-
se 1…8 

Merge 1…4 Anzeige Empfangsprotokoll, Mergequellen, Darstellung 
DMX-Eingangswerte (grafisch, prozentual, hexadezimal), 
Verify-Funktion 

Out-
Univer-
se 1…8 

Mode, Verify, Range Anzeige Ausgangsprotokoll, Darstellung DMX-
Ausgangswerte (grafisch, prozentual, hexadezimal), Verify-
Funktion 

Config Port 
Setup 

Port 1…8 Einstellen der DMX-Anschlüsse als In oder Out 

Termination Port 7/8 Einschalten der Terminierung fürPort 7/8 

Routing Network 
Out 

Universe 1…8 Einstellen des Merging von Daten in Richtung Ethernet 

DMX-
Out 

Universe 1…8 Einstellen des Merging von Daten in Richtung DMX mit 
Auswahl der Datenquellen, Verhalten bei keinem Daten-
ausfall Ethernet mit Auswahl Universe 

DMX DMX-
Port 

1..8 Auswahl des DMX-Out-Ports 

Timeout Einstellen des Timeouts des Mergepuffers für Datenausfall 

Protocol length Einstellung der Protokolllänge 

Break Einstellung der Break-Länge 

Mark after break Einstellung der Länge des Mark-after-Break. 

Mark before break Einstellung der Länge des Mark-before-Break. 

Protocol stretching Einstellung, ob das DMX-Frame gestreckt werden soll und 
wenn ja wie lang. 

Calculated prot. Ti-
me 

Nur Anzeige!  
Kalkulierte Länge des DMX-Frame aufgrund der Einstellun-
gen 

RDM Haupteinschaltung RDM für gewählten Port 

 Schaltet die Discovery ein. 

Filter Für kommende Anwendungen 

Def Laden Default-Werte aller DMX-Einstellungen für max. Da-
tengeschwindigkeit. Zum Aktivieren müssen Einstellungen 
gespeichert werden. 

Options RDM-Intervall Einstellung der Intervallzeiten für Discovery. 

Incremental dis-
covery 

Einschalten der Incremental Discovery. 

Background dis-
covery 

Einschalten des Background Modus für Incremental Dis-
covery. 

Patch enable Für kommende Anwendungen 

Static filter Für kommende Anwendungen 

RDM Discover Für kommende Anwendungen 

Ether-
net 

Receive protocol Einstellung des Empfangsprotokolls. 

Receive timeout (s) Einstellung des Timeouts beim Datenempfang. 

Transmit protocol Einstellung des Sendeprotokolls. 
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Max. frame distance Einstellung der Mindestsenderate, wenn sich die Sende-
Werte nicht ändern. 

IP Manual Manuelle Eingabe von IP-Adresse, Subnet und Gateway. 

Protocoll IP-Adresse nach gewählter Protokollvorgabe bzw. von Ser-
ver 

Options SLPv3 Aktiviert das Service Location Protocol. 

RDM (E1.33) Einstellung des Sendeprotokoll für RDM. Off: Kein RDM, 
ArtNet: Sendet via Artnet, RDMNet: nicht zertifiziert! 

Telnet Aktiviert Telnet-Protokoll für Log-Meldungen. 

Art-Net III network 
address 

Einstellung einer ArtNet 3 IP-Adresse. 

Art-Net send full 
broadcast 

ArtNet wird als Broadcast gesendet. Nur für ADB-Anlagen. 

Art-Net/sACN 
transmit length 

Aktiviert sACN Draft-Modus. 

Transmit sACN 
(E1.31) Draft 

Aktiviert sACN Draft-Modus. 

UDPChksm Einstellung der Prüfsummenberechnung. 

Ethernet Media  Einstellung der Ethernet-Übertragungsgeschwindigkeit. 

Remote protocol Einstellung eines Remoteprotokolls für Handshake mit 
Prima NT-Konsolen bzw. Salzbrenner Stagetec  

Profibus DP Address Einstellung der Profibus-Slaveadresse 

Ident Auswahl der Profibus-Identifizierung 

Separate bufs Einstellung, ob eingehende DP-Daten auf alle oder einzel-
ne MergeBuffer aufgeteilt werden. 

Monitor DP to DMX/Eth Ruft den Monitor für Datenausgang von Profibus ins DMX 
oder Ethernet auf. 

DMX/Eth to DP Ruft den Monitor für Dateneingang von DMX oder Ether-
net in den Profibus auf. 

Cue 
mem 

Control mode Einstellung des Mediums bzw. Gerätes, über das das LSS 
MasterGate gesteuert wird. 

Dim mode tmo Zeit bis die Registeranzeige in die Betriebsanzeigezurück-
kehrt 

View Aufruf des Monitors Lichtstimmungen 

Options CPU Info Anzeige von CPU-Informationen 

Component Infos Anzeige von Hardware-Daten 

Software Info Anzeige von Software-Daten inkl. Firmware-Version 

Display 
Options 

Menu timeout (w/o monitors) Timeout für Verlassen des Menüs bei Nichteingabe und 
Rückkehr zur Betriebsanzeige. Gilt nicht für die Monito-
ring-Seiten. 

Cue memory page timeout Für kommende Anwendungen 

Screensaver timeout Timeout für Backlight-Abschaltung des Displays. Außer für 
Vorführungen, Messen usw. sollte diese immer aktiviert 
werden, um das LED-Backlight des Displays zu schonen. 

Screensaver LEDs Einstellung ob Front-LEDs mit dem Display abgeschaltet 
werden 

Screensaver Events Einstellung, ob Display (und Betriebs-LEDs) durch Ände-
rungen an den Anschlüssen "aufwachen" sollen 

Remote programming Schaltet den Zugriff von LSS ConfigCore auf das LSS Mas-
terGate frei 

Fan control Einstellungen für den Gehäuselüfter 

Security Password Festlegung eines Zugangspasswortes 

Restore Settings Speichern und Laden von bis zu 100 eigenen Geräteein-
stellungen. Laden von Werkseinstellungen. 

Watchdog reset  
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Monitoring mit dem View-Menü 

Aufbau des View-Menüs 

Mit den Anzeigen im View-Menü erhalten Sie einen Überblick über aktuellen Einstellungen, Daten-
transfer und Mergesituation des LSS MasterGate. Die Anzeigen sind alle in Echtzeit. Die Anzeigen 
im View-Menü verstehen sich als Monitoring. Dadurch lassen sie sich problemlos als Überwa-
chungs- und Diagnosetools einsetzen. 

 

Ebene 1 Ebene 2 Ebene 3 Ebene 4  

View DMX DMX-In 
1…8 

Mode, Verify, Range Darstellung DMX-Eingangswerte (grafisch, prozentual, he-
xadezimal), Verify-Funktion 

DMX-
Out 1…8 

Mode, Verify, Range Darstellung DMX-Ausgangswerte (grafisch, prozentual, he-
xadezimal), Verify-Funktion 

RDM In 1…8 Für kommende Anwendungen 

Out 1…8 Für kommende Anwendungen 

Ether-
net 

In-
Univer-
se 1…8 

Merge 1…4 Anzeige Empfangsprotokoll, Mergequellen, Darstellung 
DMX-Eingangswerte (grafisch, prozentual, hexadezimal), 
Verify-Funktion 

Out-
Univer-
se 1…8 

Mode, Verify, Range Anzeige Ausgangsprotokoll, Darstellung DMX-
Ausgangswerte (grafisch, prozentual, hexadezimal), Verify-
Funktion 

 

 

Die DMX Monitore  

Das Menü View→DMX gibt einen Überblick über die Aktivitäten an den DMX- Anschlüsse. Im Un-
termenü für alle Anschlüsse können die Signale für jedes Bit hexadezimal oder prozentual darge-
stellt werden.  

 

Alle Monitoring-Anzeigen können mit VERIFY arbeiten und sind somit ein universelles Hilfsmittel 
auch für einmalige Ereignisse („Flickerfinder“). 

 

 

View→DMX→DMX-Monitor 

Im DMX-Monitor wird auf der Übersichtsseite zunächst der Zustand der Schnittstellen angezeigt:  

 

Symbol Bedeutung 

-- Nicht als DMX-In oder Out definiert 

Leerer Kreis Als DMX-In oder Out definiert, kein Datentransfer 

Gefüllter Kreis Als DMX-In oder Out definiert, Datentransfer läuft 
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View→DMX→DMX-Monitor→Port n 

Eine ausgefüllte LED bedeutet „Schnittstelle/Puffer aktiv“, leer bedeutet „nicht aktiv“. Die LEDs 
können direkt angewählt werden und mit Drücken des Encoders gelangt man so in die Monitor-
Anzeige der einzelnen Anschlüsse: 

 

Im DMX-Monitor können alle Kreise des angewählten 
DMX-In oder DMX-Out in ihrem Wert grafisch als Bal-
kenanzeige oder als Prozentwert und Hexadezimalzahl 
dargestellt werden. Die Umschaltung geschieht mit 
„Mode“. 

 

 

In der Titelzeile werden verschiedene Messwerte angezeigt: 

 

Symbol Bedeutung 

On/Off Zustand des In oder Out 

T Senderate des Out in ms 

C Channel-Anzahl des DMX-In-Protokolls 

P (grobe) Protokolldauer des DMX-In-Protokolls 

S Startcode des DMX-In-Protokolls 

 

Unterhalb der Anzeigen können folgende Einstellungen vorgenommen werden. 

 

Einstellung Bedeutung 

Page Auswahl der Anzeigeseiten. Zur besseren Übersicht für zusammenhängende Kreise 
blättert das LSS MasterGate in allen Monitoring-Anzeigen immer nur um 2 Zeilen. 

Mode Schaltet zwischen grafischer und Zahlenanzeige um. 

Verify Schaltet den Verify-Modus ein  (Anzeige [V] rechts oben im Display). 

Range Aufruf des Menüs zur Einschränkung des Verify-Bereiches. 

OK Eine Menüebene zurück. 

 

 

In diesem Monitor ist die selbsttätige Rückkehr in die Betriebsanzeige  außer Kraft 
gesetzt, um auch längere Beobachtungen zu ermöglichen. 

 

  



LSS MasterGate 

 
LSS 29 

 

 

 

Verify-Modus 

Mit dem Einschalten des Verify-Modus mit „Verify“ (rechts oben wird nun ein V angezeigt) wird 
exakt der aktuelle Zustand eingespeichert und im nun laufend mit den aktuellen Daten verglichen. 
Bei einer auch nur kurzzeitigen Abweichung der Daten (es genügt ein Bit) wird der Verify abgebro-
chen und das Ergebnis dargestellt (rechts oben ein nicht-inverses V). Mit einem lauten Signalton 
macht das LSS MasterGate auf den Verify-Fehler aufmerksam. Erneutes Drücken auf „Verify“ 
schaltet den Verify-Modus ab (rechts oben kein V). 

 

Man kann damit über lange Messzeiten Protokollstörungen, -verschiebungen und Flackern durch 
defekte Geräte diagnostizieren, ohne einen speziellen DMX-Tester mit Flickerfixer zu benötigen. 
Optional ist sogar eine externe Ausgabe des Triggerimpulses z.B. für Meßgeräte möglich. 

 

Mit dem „Range“-Menü kann der Bereich für Verify bis zu einem Stromkreis eingegrenzt werden.  

 

 

Die Ethernet-Monitore 

View→Ethernet→Ethernet-Monitor 

Auf der Übersichtsseite kann der gesamte Zustand des Netzwerks überblickt werden. Eine ausge-
füllte LED bedeutet "aktiv", leer bedeutet "nicht aktiv". Mit „Out“ gelangt man in die Übersichts-
seite der vom LSS MasterGate gesendeten Universes. 

 

Untereinander sind in zwölf Zeilen die zwölf Empfangsmöglichkeiten für die zwölf Mergepuffer 

dargestellt. Subnet und Universe entsprechen den im RoutingDMX-Out eingestellten. Daneben 
verdeutlichen je drei Punkte die möglichen drei Sender, die auf dem gleichen Subnet und Universe 
empfangen und gemergt werden können.  

 

 

Die Empfangspuffer zeigen den Empfang aus den eingestellten Subnets und Univer-
ses auch dann an, wenn das Ethernet als Quelle im Routing ausgeschaltet ist (und 
somit das LSS MasterGate selbst diese Universes nicht verwendet)! 

 

View→Ethernet→Ethernet-Monitor→In-Port n 

Eine ausgefüllte LED bedeutet „Schnittstelle/Puffer aktiv“, leer bedeutet „nicht aktiv“. Die LEDs 
können direkt angewählt werden und mit Drücken des Encoders gelangt man so in die Monitor-
Anzeige, die in Bedienung und Darstellung exakt der des DMX-Monitors entspricht (siehe 
View→DMX→DMX-Monitor→Port n Die DMX Monitore ). 
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Der einzige Unterschied besteht darin, dass in der obers-
ten Zeile die IP- bzw. (bei AVAB/IPX-Protokoll) die MAC-
Adresse des Senders zu sehen ist, der auf diesem Socket 
sendet. Somit kann festgestellt werden, welche Anlagen 
auf dem gleichen Subnet/Universe mit welchen Werten 
zur Summe beitragen. 

Werden Daten weder empfangen noch gesendet, steht 
über der Monitorseite „Socket not used“.  

 

In der Titelzeile werden angezeigt: 

 

Symbol Bedeutung 

In/Out In oder Out 

1/1 Merge-Puffernummer (1…12) / Merge-Teilnehmer (1…3) 

Adresse bei In:   IP/MAC-Adresse des Senders;  

bei Out:  die eigene IP/MAC des LSS MasterGate 

Zahl Paketzähler 

 

 

View→Ethernet→Ethernet-Monitor→Out 

Untereinander sind in zwölf Zeilen die zwölf aussendbaren Mergepuffer des LSS MasterGate dar-

gestellt. Subnet und Universe entsprechen den im RoutingEthernet Out eingestellten. 

Auch hier kann die LED direkt angewählt werden. Das Monitoring ist genau wie bei In möglich. 
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Funktionseinstellungen im Config-Menü 

 

 

Bitte beachten Sie, dass jede Änderung der Einstellungen weitreichende Folgen auf 
Ihre Lichtanlage haben kann. Die folgend beschriebenen Einstellungsmöglichkeiten 
setzen auch voraus, dass Sie Erfahrungen und Kenntnisse in der DMX- Konfiguration 
besitzen. 

 

Aufbau des Config-Menüs 

Ebene 2 Ebene 3 Ebene 4 Einstellungsmöglich-
keiten 

Bedeutung 

Port 
Setup 

Port 1…8 DMX-Out, DMX-In, N/A Einstellen der DMX-Ports als In oder Out 

Termination  Port 7/8 Off, On Einschalten der Terminierung fürPort 7/8 

Routing Network 
Out 

Universe 1…8 Off, DMX-Out, DMX-In Einstellen des Merging von Daten in Richtung 
Ethernet 

DMX-
Out 

Universe 1…8 DMX-In 1…8, Profibus 
On/Off, Ethernet Off, 
Single, Merge4, Uni-
verse 1…99999 

Einstellen des Merging von Daten in Richtung 
DMX mit Auswahl der Datenquellen, Verhalten 
bei keinem Datenausfall Ethernet mit Auswahl 
Universe 

DMX DMX-
Port 

1..8 1…8 Auswahl des DMX-Out-Ports 

Timeout Hold, 1…10 Einstellen des Timeouts des Mergepuffers für 
Datenausfall 

Protocol length 2…512 Einstellung der Protokolllänge 

Break 90…200...42000 µs Einstellung der Break-Länge 

Mark after 
break 

10, 20…42000µs Einstellung der Länge des Mark-after-Break. 

Mark before 
break 

0…42000µs Einstellung der Länge des Mark-before-Break. 

Protocol stret-
ching 

0…999 Einstellung, ob das DMX-Frame gestreckt werden 
soll und wenn ja wie lang. 

Calculated 
prot. Time 

  Nur Anzeige!  
Kalkulierte Länge des DMX-Frame aufgrund der 
Einstellungen 

RDM Off, On Haupteinschaltung RDM für gewählten Port 

  Discovery Schaltet die Discovery ein. 

Filter   Für kommende Anwendungen 

Def   Laden Default-Werte aller DMX-Einstellungen für 
max. Datengeschwindigkeit. Zum Aktivieren 
müssen Einstellungen gespeichert werden. 

Options RDM-Intervall 1...10…9999 Einstellung der Intervallzeiten für Discovery. 

Incremental 
discovery 

Off, On Einschalten der Incremental Discovery. 

Background 
discovery 

Off, On Einschalten des Background Modus für Incre-
mental Discovery. 

Patch enable   Für kommende Anwendungen 

Static filter   Für kommende Anwendungen 

RDM Discover   Für kommende Anwendungen 
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Ebene 2 Ebene 3 Ebene 4 Einstellungsmöglich-

keiten 
Bedeutung 

Ethernet Receive protocol sACN, ShowNet, 
AVAB/UDP, AVAB/IPX, 
Art-Net2, Default 

Einstellung des Empfangsprotokolls. 

Receive timeout (s) 0...8…999 Einstellung des Timeouts beim Datenempfang. 

Transmit protocol sACN, ShowNet, 
AVAB/UDP, AVAB/IPX, 
Art-Net2, Default 

Einstellung des Sendeprotokolls. 

Max. frame distance 20ms, 25ms, 40ms, 
50ms, 0.1s, 0.2s, 0.5s, 
1s, 2s, 3s, 4s 

Einstellung der Mindestsenderate, wenn sich die 
Sende-Werte nicht ändern. 

IP Manual IP, Subnet & Gateway Manuelle Eingabe von IP-Adresse, Subnet und 
Gateway. 

Protocoll Art-Net2, Art-Net10, 
DHCP 

IP-Adresse nach gewählter Protokollvorgabe 
bzw. von Server 

Options SLPv3 Off, On Aktiviert das Service Location Protocol. 

RDM (E1.33) Off, ArtNet, RDMNet Einstellung des Sendeprotokoll für RDM. Off: 
Kein RDM, ArtNet: Sendet via Artnet, RDMNet: 
nicht zertifiziert! 

Telnet On, Off Aktiviert Telnet-Protokoll für Log-Meldungen. 

Art-Net III net-
work address 

0…127 Einstellung einer ArtNet 3 IP-Adresse. 

Art-Net send 
full broadcast 

Off, On ArtNet wird als Broadcast gesendet. Nur für ADB-
Anlagen. 

Art-Net/sACN 
transmit length 

2...512 Aktiviert sACN Draft-Modus. 

Transmit sACN 
(E1.31) Draft 

Off, On Aktiviert sACN Draft-Modus. 

UDPChksm Rx & Tx, Rx only, Tx on-
ly, Off 

Einstellung der Prüfsummenberechnung. 

Ethernet Media  Autoneg., 10 Half, 10 
Full, 100 Half, 100 Full 

Einstellung der Ethernet-
Übertragungsgeschwindigkeit. 

Remote proto-
col 

Off, DigiPlus, Nexus Einstellung eines Remoteprotokolls für Handsha-
ke mit Prima NT-Konsolen bzw. Salzbrenner Sta-
getec  

Profibus DP Address 0…126 Einstellung der Profibus-Slaveadresse 

Ident MasterGate, ProfiGate Auswahl der Profibus-Identifizierung 

Separate bufs Off, On Einstellung, ob eingehende DP-Daten auf alle o-
der einzelne MergeBuffer aufgeteilt werden. 

Monitor DP to DMX/Eth  Ruft den Monitor für Datenausgang von Profibus 
ins DMX oder Ethernet auf. 

DMX/Eth to DP  Ruft den Monitor für Dateneingang von DMX o-
der Ethernet in den Profibus auf. 

Cue 
mem 

Control mode Profibus, DMX-In 8, 
Art-Net, 6 In, 6+8 In, 
Kbd+ 6In, Kbd+14In, 
Keyboard, Kbd+Art 

Einstellung des Mediums bzw. Gerätes, über das 
das LSS MasterGate gesteuert wird. 

Dim mode tmo Off, 15s, 30s, 1m, 3m, 
5m, 10m 15m, 20m, 
30m, 45m, 1h, 2h, 3h, 
4h, 6h, 8h, 12h, 24h 

Zeit bis die Registeranzeige in die betriebsanzei-
ge zurückkehrt 

View   Aufruf des Monitors Lichtstimmungen 
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Einstellen der DMX-Anschlüsse – PortSetup 

Im Menü PortSetup werden die DMX-Anschlüsse als Ein- oder Ausgänge definiert. Sie können auch 
abgeschaltet werden, die Definition als virtueller Ausgang bleibt aber der Konfiguration mit Con-
figCore vorbehalten.  

 

Ebene 2 Ebene 3 Ebene 4 Einstellungsmöglich-
keiten 

Bedeutung 

Port 
Setup 

Port 1…8 DMX-Out, DMX-In, N/A Einstellen der DMX-Ports als In oder Out 

Termination  Port 7/8 Off, On Einschalten der Terminierung fürPort 7/8 

 
 

Symbol Bedeutung 

N/A DMX-Anschluss ist abgeschaltet 

DMX-In DMX-Anschluss ist als DMX-Eingang definiert 

DMX-Out DMX-Anschluss ist als DMX-Ausgang definier 

 

Terminieren der DMX-Anschlüsse 7 und 8 

Die Ports 7 und 8 besitzen jeweils einen schaltbaren DMX-Terminator. DMX-Signale müssen zwi-
schen dem ersten und letzten Gerät terminiert werden, um Störsignale zu vermeiden. Geräte in-
nerhalb einer DMX-Linie dürfen aber keinen Terminator aktiviert haben.  

 

Symbol Bedeutung 

Off Terminator ist abgeschaltet. 

On Terminator ist eingeschaltet. 
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Konvertieren und Mergen von Daten – Routing 

Einleitung 

Zum Konvertieren und Mergen von Daten stehen insgesamt acht Mergepuffer zur Verfügung, die 
den DMX-Anschlüssen zugeordnet sind. Von diesen Puffern werden dann die Daten in das jeweili-
ge Medium gesendet. Immer wird dabei ein Puffer, also ein DMX-Anschluss belegt, auch wenn das 
Zielmedium nicht DMX ist! 

 

 

Für die Einstellungen zum Konvertieren und Mergen von Daten ist es zweckmäßig, 
von Ende her, also dem Zielmedium, zu denken. 

 

 

Sollen die Daten in den Profibus gemergt werden, muss dies an der SPS parametriert 
werden. 

 

 

1. Einstellen von Mergepuffers und Datenquellen – Routing→DMX-Out 

Zum Konvertieren und Mergen ist ein Mergepuffer notwendig. In den Einstellungen ist jeder Puffer 
einem DMX-Out zugeordnet, auch wenn das Signal ins Ethernet gemergt wird.  

 

Auswahl des Mergepuffers mit 

Routing → DMX-Out → Port 1…8 

Ebene 2 Ebene 3 Ebene 4 Einstellungsmöglich-
keiten 

Bedeutung 

Routing Network 
Out 

1…8 Off, DMX-Out, DMX-In Einstellen des Merging von Daten in Richtung 
Ethernet 

DMX-
Out 

Port 1…8 DMX-In 1…8, Profibus 
On/Off, Ethernet Off, 
Single, Merge4, Uni-
verse 1…99999 

Auswahl des Mergepuffers und der Datenquel-
len, bei Ethernet zusätzlich Verhalten bei Daten-
ausfall und Auswahl Universe 

 

Auswahl Bedeutung 

DMX-In Auswahl eines DMX-In als Datenquelle. Es werden nur DMX-Anschlüsse angezeigt, 
die als DMX-In definiert sind. 

● DMX-In ist als Datenquelle ausgewählt 

○ DMX-In ist nicht ausgewählt 
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Auswahl Bedeutung 

Profibus Off:  Profibus ist nicht als Datenquelle zum Mergen ausgewählt 

On:  Profibus ist als Datenquelle zum Mergen ausgewählt 

Cue mem Die Stimmungsspeicher können nicht am Gerät als Datenquelle ausgewählt werden. 

Ethernet OFF:  Es werden keine Ethernet-Daten berücksichtigt 

Single:  Es werden nur die vom ersten Sender empfangenen Lichtdaten hinzu-
gemergt. Sollten gleichzeitig von mehreren Sendern Telegramme mit 
dem eingestellten Subnetz und Universe anliegen, wird nur der erste 
erkannte Sender berücksichtigt. Die Sender-Erkennung erfolgt bei 
sACN durch die CID, bei AVAB/IPX durch die MAC-Adresse und bei al-
len anderen Protokollen durch die IP-Adresse des Senders, die für je-
den Sender individuell sein muss. Bei Ausbleiben des Signals wird nach 
der Timeout-Zeit ggf. ein anderer Sender ermittelt (Prinzip: „Der Erste 
darf“). 

Merge 4:  Es werden die Daten von bis zu 4 Ethernet-Sendern nach dem HTP-
  Prinzip zusammengefasst. Sollten gleichzeitig von mehr als 3 Sendern 
  Telegramme mit dem Subnetz und Universe dieses Ausgangs  
  anliegen, werden nur die ersten 4 erkannten Sender berücksichtigt. 
  Bei Ausbleiben eines Signals wird nach der Timeout-Zeit ggf. ein an
  derer Sender ermittelt (Prinzip: „Wer zuerst kommt“).  

Universe/ 
Subnet 

Einstellen des Universe/Subnets je nach Lichtprotokoll 

 

 

Auch beim Konvertieren von Ethernet-Protokoll zu Ethernet-Protokoll muss der Weg 
über die Mergepuffer gewählt werden! 
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2. Einstellen des Zielmediums Ethernet/DMX/Profibus 

2.1. Zielmedium Ethernet 

Soll der Inhalt des Mergepuffers ins Ethernet gesendet werden, wird dies im Menü Routing → 
Network-Out → 1…8 eingestellt. 

 

Ebene 2 Ebene 3 Ebene 4 Einstellungsmöglich-
keiten 

Bedeutung 

Routing Network 
Out 

1…8 Off, DMX-Out, DMX-In Einstellen des Merging von Daten in Richtung 
Ethernet 

DMX-
Out 

Out 1…8 DMX-In 1…8, Profibus 
On/Off, Ethernet Off, 
Single, Merge4, Uni-
verse 1…99999 

Einstellen des Merging von Daten in Richtung 
DMX mit Auswahl der Datenquellen, Verhalten 
bei keinem Datenausfall Ethernet mit Auswahl 
Universe 

 

Auswahl Bedeutung 

1…8 Auswahl des Mergepuffers, dessen Inhalt ins Ethernet gesendet werden soll. 

Off Der Inhalt des Mergepuffers wird nicht ins Ethernet gesendet. Der Inhalt steht aber 
anderen Medien zur Verfügung. 

DMX-Out Der Inhalt des Mergepuffers wird ins Ethernet gesendet. 

 

 

Sollte der DMX-Anschluss als DMX-Out definiert sein, wird der Inhalt des 
Mergepuffers parallel auch über den DMX-Anschluss gesendet. 

 

DMX-In Ist der DMX-Anschluss als DMX-In definiert, werden die eingehenden DMX-Signale 
direkt ohne den Inhalt des Mergepuffers ins Ethernet gesendet. 

 

 

Sollen die Daten des DMX-In mit dem Mergepuffer gesendet werden, 
muss der DMX-In als Datenquelle im Mergemenü eingetragen und in 
diesem Menü die Einstellung DMX-Out gewählt weden. 

 

 

Werden die Daten des DMX-In direkt ins Ethernet gesendet, kann der 
Inhalt des Mergepuffers für andere Zielmedien, z.B. Profibus, verwendet 
werden. 

 

Universe/ 
Subnet/Priorität 

Einstellen des Universe/Subnets/Priorität je nach Lichtprotokoll 

 

 

Wird die Einstellung DMX-In gewählt, obwohl der DMX-Anschluss NICHT als DMX-In 
definiert ist, wird die Einstellung beim Bestätigen mit „OK“ automatisch in DMX-Out 
umgewandelt. Wird nun erst der Anschluss als In definiert, wird dieAuswahl in die-
sem Menü nicht der neuen Definition angepasst! 
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2.2. Zielmedium DMX 

Sollen die Daten im Mergepuffer ins DMX-Netz gesendet werden, muss der DMX-Anschluss als 
DMX-Out definiert werden. Die Daten im Mergepuffer liegen automatisch am DMX-Anschluss an. 
Das ausgehende DMX-Signal kann im Konfigurationsmenü DMX noch manipuliert werden. 

 

Ebene 2 Ebene 3 Ebene 4 Einstellungsmöglich-
keiten 

Bedeutung 

Port 
Setup 

Port 1…8 DMX-Out, DMX-In, N/A Einstellen der DMX-Ports als In oder Out 

Termination  Port 7/8 Off, On Einschalten der Terminierung fürPort 7/8 

 

 
Die Daten am DMX-Out können parallel auch über Ethernet gesendet werden. 

 

2.3. Zielmedium Profibus 

Die Daten des Mergepuffers können auch in den Profibus gesendet werden. Die Einstellung muss 
aber an der SPS vorgenommen werden, da das LSS MasterGate in diesem Bussystem nur als Slave 
eingebunden ist.  

 

 

Auch bei Mergen für Profibus wird ein Mergepuffer benötigt. Um den dazu gehören-
den DMX-Anschluss nicht „zu verschwenden“, bietet sich eine Anschluss-Definition 
als DMX-In an. Das eigehende Signal kann, muss aber nicht, in den Mergepuffer als 
Datenquelle einbezogen werden. Der Anschluss kann auch, trotz des belegten eige-
nen Puffers, für andere Mergepuffer als Datenquelle dienen. 
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Einstellen des DMX- und RDM-Protokolls – Config-DMX 

In diesem Menü werden die technischen Einstellungen für die DMX-Anschlüsse vorgenommen. Die 
Einstellungen können separat für jeden Anschluss vorgenommen werden.  

 

Die Anzeige „result/fps“ gibt die durchschnittliche Dauer eines DMX-Frames an. Sie wird errechnet 
aus Protocol length, Break, MAB, MBS und MBB. Beim Wert = 44 wird das DMX-Signal mit maxima-
ler Geschwindigkeit gesendet.  

 

 

Durch Ändern der Default-Werte können hier Werte erzeugt werden, die für die Sta-
bilität des Netzwerkes und der Lichtsteuerung gefährliche Auswirkungen haben kön-
nen! Die Default-Einstellungen sollten aus diesem Grund nicht geändert werden! 

 

Ebene 2 Ebene 3 Ebene 4 Einstellungsmöglich-
keiten 

Bedeutung 

DMX DMX-
Port 

1..8 1…8 Auswahl des DMX-Out-Ports 

Timeout Hold, 1…10 Einstellen des Timeouts des Mergepuffers für 
Datenausfall 

Protocol length 2…512 Einstellung der Protokolllänge 

Break 90…200...42000 µs Einstellung der Break-Länge 

Mark after 
break 

10, 20…42000µs Einstellung der Länge des Mark-after-Break. 

Mark before 
break 

0…42000µs Einstellung der Länge des Mark-before-Break. 

Protocol stret-
ching 

0…999 Einstellung, ob das DMX-Frame gestreckt werden 
soll und wenn ja wie lang. 

Calculated 
prot. Time 

 Nur Anzeige!  
Kalkulierte Länge des DMX-Frame aufgrund der 
Einstellungen 

RDM Off, On Haupteinschaltung RDM für gewählten Port 

 Discovery Schaltet die Discovery ein. 

Filter  Für kommende Anwendungen 

Def  Laden Default-Werte aller DMX-Einstellungen für 
max. Datengeschwindigkeit. Zum Aktivieren 
müssen Einstellungen gespeichert werden. 

Options RDM-Intervall 1...10…9999 Einstellung der Intervallzeiten für Discovery. 

Incremental 
discovery 

Off, On Einschalten der Incremental Discovery. 

Background 
discovery 

Off, On Einschalten des Background Modus für Incre-
mental Discovery. 

Patch enable  Für kommende Anwendungen 

Static filter  Für kommende Anwendungen 

RDM Discover  Für kommende Anwendungen 
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Einstellen des DMX-Protokolls – DMX-Port 

Aufbau des DMX-Protokolls 

 

 
 

Die obige Zeichnung zeigt den Aufbau eines DMX-Frames. Einzelne Teile eines Frames können 
manipuliert werden, um das Frame zu strecken oder zu stauchen, so dass die Geschwindigkeit der 
Übertragung verändert wird.  

 

Einstellungsmöglichkeiten 
 

Einstellung Bedeutung 

1..8 Auswahl des DMX- Anschlüsse. Ob der Anschluss als eingehendes (In) oder 
ausgehendes (Out) Universum definiert ist, wird hinter der Port-Nummer an-
gezeigt. 

Timeout Port = In: Empfangs-Timeout bei Empfangs-Ausfall. Nach Ablauf der 
eingestellten Zeit, wird der DMX-In als Merge-Quelle abge-
schaltet. 

Port = Out: Sende-Timeout wenn der Mergepuffer/DMX-Out keine Daten 
mehr erhält 
 

 Hold: Der letzte Wert wird unverändert weiter gesendet. 
 1…10: Nach Ablauf der eingestellten Zeit wird der Merge-

puffer/DMX-Out abgeschaltet. 
 

Protocol 
length 

(nur wenn der Port als Out definiert ist) 

0…512: Anzahl der Universes/Slots pro Frame 

Break (nur wenn der Port als Out definiert ist) 
Stellt die Länge des Breaks für das gewählte Universum ein. 

Mark after 
break 

(nur wenn der Port als Out definiert ist) 
Stellt die Länge des Marks nach dem Break (MAB) für das gewählte Universum 
ein. 
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Einstellung Bedeutung 

Mark before 
break 

(nur wenn der Port als Out definiert ist) 
Stellt die Länge des Marks vor dem Break für das gewählte Universum ein. 

Protocol 
stretching 

(nur wenn der Port als Out definiert ist) 
Einstellung, ob das DMX-Frame gestreckt werden soll und wenn ja wie lang. 

Calculated 
prot. Time 

Hier wird die kalkulierte Länge eines DMX-Frames angezeigt, die aus den obi-
gen Einstellungen errechnet wird. 

RDM On: Schaltet das RDM für den gewählten Anschluss ein. 
Off: Schaltet das RDM für den gewählten Anschluss aus. 
Das LSS MasterGate tritt an definierten Out-Anschlüssen als RDM-
Controller und an definierten In-Anschlüssen als Responder auf. 

 

Discovery 

(nur sichtbar, 
wenn RDM 
aktiv und 
mindestens 
ein Anschluss 
als Out defi-
niert ist) 

On: Aktiviert die RDM-Discovery Funktion für den ausgewählten An-
schluss. 

Off: Deaktiviert die RDM-Discovery Funktion für den ausgewählten An-
schluss. 

 

 

Eine neu angestoßene volle RDM-Discovery verursacht 
kurzzeitig hohen Datentraffic im Universe und kann die DMX-
Steuerung beeinträchtigen! 

 

Filter Diese Einstellung ist für zukünftige Funktionen reserviert. 

 
 

Laden der DMX-und RDM-Default-Werte – DMX→Def 

„Def“ lädt die Default-Werte aller Einstellungen, die im Menü „DMX“ und dem Untermenü Opti-
ons eingestellt werden. Es werden keine Default-Werte in anderen Menüs geladen und es findet 
kein Reset des Gerätes statt. 
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Einstellen der RDM-Funktion – DMX→Options 

In diesem Untermenü werden die globalen, für alle Universen geltenden RDM-Einstellungen fest-
gelegt. 

Einstellung Bedeutung 

RDM-Intervall Stellt die Intervallzeiten der der inkrementellen Discovery in Sekunden ein. 

Incremental 
discovery 

Mit dieser Funktion ist RDM-Discovery immer aktiv! Es werden immer Daten 
gesammelt und Identifizierungsanfragen für neue Geräte in die Universen ge-
sendet.  

On: Incremental discovery ist immer aktiv. 

Off: Incremental discovery ist nicht aktiv. 

Background 
discovery 

Mit dieser Funktion arbeitet die inkrementelle Discovery im Hintergrund. 
Dadurch wird das DMX-Signal weniger gestört. Allerdings kann es sein, dass sich 
die Intervallzeit weit über oben eingestellte hinaus verlängert! 

On: Background discovery ist aktiv. 

Off: Background discovery ist nicht aktiv. 

Patch enable Für kommende Anwendungen 

Static filter Für kommende Anwendungen 

RDM Discover Für kommende Anwendungen 

 

 

RDM-Discovery verursacht sehr hohen Datentraffic in den Universen! Das kann die 
DMX-Steuerung beeinträchtigen oder sogar unmöglich machen! 
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Einstellen der Netzwerkparameter – Ethernet 

Ebene 2 Ebene 3 Ebene 4 Einstellungsmöglich-
keiten 

Bedeutung 

Ethernet Receive protocol sACN, ShowNet, 
AVAB/UDP, AVAB/IPX, 
Art-Net2, Default 

Einstellung des Empfangsprotokolls. 

Receive timeout (s) 0...8…999 Einstellung des Timeouts beim Datenempfang. 

Transmit protocol sACN, ShowNet, 
AVAB/UDP, AVAB/IPX, 
Art-Net2, Default 

Einstellung des Sendeprotokolls. 

Max. frame distance 20ms, 25ms, 40ms, 
50ms, 0.1s, 0.2s, 0.5s, 
1s, 2s, 3s, 4s 

Einstellung der Mindestsenderate, wenn sich die 
Sende-Werte nicht ändern. 

IP Manual IP, Subnet & Gateway Manuelle Eingabe von IP-Adresse, Subnet und 
Gateway. 

Protocoll Art-Net2, Art-Net10, 
DHCP 

IP-Adresse nach gewählter Protokollvorgabe 
bzw. von Server 

Options SLPv3 Off, On Aktiviert das Service Location Protocol. 

RDM (E1.33) Off, ArtNet, RDMNet Einstellung des Sendeprotokoll für RDM. Off: 
Kein RDM, ArtNet: Sendet via Artnet, RDMNet: 
nicht zertifiziert! 

Telnet On, Off Aktiviert Telnet-Protokoll für Log-Meldungen. 

Art-Net III net-
work address 

0…127 Einstellung einer ArtNet 3 IP-Adresse. 

Art-Net send 
full broadcast 

Off, On ArtNet wird als Broadcast gesendet. Nur für ADB-
Anlagen. 

Art-Net/sACN 
transmit length 

2...512 Einstellung der Anzahl der Universes bei Art-Net 
und sACN 

Transmit sACN 
(E1.31) Draft 

Off, On Aktiviert sACN Draft-Modus. 

UDPChksm Rx & Tx, Rx only, Tx on-
ly, Off 

Einstellung der Prüfsummenberechnung. 

Ethernet Media  Autoneg., 10 Half, 10 
Full, 100 Half, 100 Full 

Einstellung der Ethernet-
Übertragungsgeschwindigkeit. 

Remote proto-
col 

Off, DigiPlus, Nexus Einstellung eines Remoteprotokolls für Handsha-
ke mit Prima NT-Konsolen bzw. Salzbrenner Sta-
getec  

Die Mac-Adresse und die Seriennummer sind reine Anzeigen und können nicht verändert werden.  

 

Einstellungen Bedeutung 

Receive 

Protocol 

Einstellung des Empfangs-Netzwerkprotokolls 

Receive time-
out 

Einstellung des Timeouts beim Datenempfang 

0 = letztes Protokoll halten 

Transmit Pro-
tocol 

Einstellung des Sende-Netzwerkprotokolls  

Default:  Sendeprotokoll entspricht dem Empfangsprotokoll  
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Einstellungen Bedeutung 

Max. frame 
distance 

Einstellung der Mindestsenderate wenn sich keine Werte ändern. 

IP Bezug der IP-Adresse:  
IP address:  freie Einstellmöglichkeit  
Art-Net 2: Art-Net-Adresse im 2er Netz  
Art-Net 10:  Art-Net-Adresse im 10er Netz  

DHCP:   wenn DHCP-Server im Netzwerk vorhanden  

Subnet mask Netzwerkmaske: die manuelle Einstellung ist nur bei „IP address“ möglich 

Gateway Gateway:  die manuelle Einstellung ist nur bei „IP address“ möglich 

 

 

 Der Timeout für DHCP nach dem Neustart des LSS MasterGate ist standardmä-
ßig 10s, danach erfolgt ein Fallback auf eine nach RFC3927 automatisch erzeug-
te IP-Adresse ("Zeroconf", 169.254.x.x). 

 
 

Configuration → Ethernet→Options 
In diesem Menü werden optionale Einstellungen vorgenommen. 
 

Einstellung Bedeutung 

SLPv3 protocol Das Service Location Protocol ist ein Netzwerkprotokoll zum Auffinden von 
Ressourcen im TCP/IP-Netz.  
On:  Aktiviert das SLPv3 Netzwerkprotokoll. 
Off:  Deaktiviert das SLPv3 Netzwerkprotokoll. 

RDM-Net (E1.33) 
protocol 

RDM-Net ist ein Protokoll zum Austausch von RDM-Meldungen über 
Ethernet. 
On:  Aktiviert das RDM-Net Netzwerkprotokoll  
  nach Standard E1.33. 
Off:  Deaktiviert das RDM-Net Netzwerkprotokoll  
  nach Standard E1.33. 
RDMNet: Ist ein bisher nicht zertifiziertes RDM-Protokoll 

Telnet Das Telnet ist ein Client/Server-Netzwerkprotokoll zum Datenaustausch 
unabhängig von Betriebssystemen. 
On:  Aktiviert das Telnet-Netzwerkprotokoll 
Off:  Deaktiviert das Telnet-Netzwerkprotokoll 

Art-Net III network 
address 

0:  Art-Net II kompatibel 

1…127: Art-Net III Netzwerkadresse 

Art-Net send full 
broadcast 

Off:  Der LSS MasterGate sendet im Art-Net-Standard 
2.xxx.xxx.xxx. 

On:  Der LSS MasterGate sendet erweiterten IP-Bereich  
   255.xxx.xxx.xxx. 
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Einstellung Bedeutung 

Art-Net/sACN 
transmit length 

Einstellung der Anzahl der Universes bei Art-Net und sACN 

Die Protokolle müssen mindestens 2 und maximal 512 Universes haben. 

Transmit sACN 
(E1.31) Draft 

Auswahl des gesendeten sACN-Protokolls  
On:  Der LSS MasterGate arbeitet mit sACN-Draft. 

Off:  Der LSS MasterGate arbeitet mit sACN-Release. 

UDP-Checksum Einstellung zur Berechnung der Prüfsummen von UDP-Datenpaketen  
Rx & Tx: Prüfsummen für empfangene und gesendete Pakete  
Rx only: Prüfsummen nur für empfangene Pakete  
Tx only: Prüfsummen nur für gesendete Pakete  

Off:  Prüfsummenberechnung aus  

Ethernet media  Einstellung der Übertragungsgeschwindigkeit  
Autoneg.: Automatische Ermittlung der Übertragungsgeschwindigkeit  
10 Half: 10MBit/s Half Duplex  
10 Full: 10MBit/s Full Duplex  
100 Half: 100MBit/s Half Duplex  

100 Full: 100MBit/s Full Duplex  

Remote protocol Einstellung der Nebenpultkopplung und des Nexus-Systems 
Off:  Nebenpultkopplung aus 
DigiPlus: DigiPlus-Nebenpultkopplung ein 
Nexus:  Nexus-Systemanbindung 

Remote timeout Einstellung des Timeouts für Nebenpultkopplung  

Remote IP Einstellung der IP-Adresse für die Nebenpultkopplung  
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Einstellen des Profibus 

Profibus-DP ist ein Feldbussystem mit Master/Slave-Einstellungen. Das bedeutet, dass das LSS 
MasterGate ist in den Profibus als Slave eingebunden ist. Die eigentliche Konfiguration und Para-
metrierung wird am Master, der SPS, vorgenommen.  

 

 

Ebene 2 Ebene 3 Ebene 4 Einstellungsmöglich-
keiten 

Bedeutung 

Profibus DP Address 0…126 Einstellung der Profibus-Slaveadresse 

Ident MasterGate, ProfiGate Auswahl der Profibus-Identifizierung 

Separate bufs Off, On Einstellung, ob eingehende DP-Daten auf alle o-
der einzelne MergeBuffer aufgeteilt werden. 

Monitor DP to DMX/Eth  Ruft den Monitor für Datenausgang von Profibus 
ins DMX oder Ethernet auf. 

DMX/Eth to DP  Ruft den Monitor für Dateneingang von DMX o-
der Ethernet in den Profibus auf. 

 

Einstellungen Bedeutung 

Address Einstellung der Profibus-Slaveadresse des LSS MasterGate 

Ident Auswahl der Profibus-Identifizierung 

Seperate bufs Off:  Von der SPS kommende Profibus-Daten werden in alle Sub-
nets/Universes ausgegeben 

On: Von der SPS kommende Profibus-Daten werden in vordefinierte 
Subnets/Universes  ausgegeben. Die Auswahl der Subnets/Universes 
wird in der SPS vorgenommen. 

 

Voraussetzung für beide Einstellungen: Profibus ist in Config→Routing akti-
viert. 

DP to DMX/Eth Aufruf des Monitors für Profibus-DP-Output. 

DMX/Eth to DP Aufruf des Monitors für Profibus-DP-Input. 

Param/Cfg Aufruf des Monitors für Profibus-Parametrierung und -Konfigurierung. 
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Unterhalb der Einstellungsmöglichkeiten werden folgende Werte angezeigt: 

 

 DP to DMX/Eth 

(vom Profibus, DP-Output) 

DMX/Eth to DP 

(zum Profibus, DP-Input) 

Parameter   

User: Nebenpultkopplung              oder 

Art-Net-Filter                        oder 

Stimmungsspeicher 

Nebenpultkopplung 

Area: Bereich von Stromkreiswerten Bereich von Stromkreiswerten 

Single / Switch: Einzelkreise Stromkreise mit Schaltschwelle 

Saddr / Switch: Startcode Stromkreise mit Schaltschwelle 

 

 

Configuration→Profibus→Para/Cfg  

Im Profibus-Monitor können alle Profibus-Bytes sowohl für Eingaben als auch für Ausgaben gra-
fisch als Balkenanzeige oder als %-Wert und Hex-Zahl beobachtet werden. Die Anzeige und Bedie-
nung ist identisch zum DMX- und Netzwerkmonitor (Ausnahme: es gibt keine Verify-Funktion) 

 

Je nach aktueller Parametrierung und Konfigurierung werden nur die Bytes dargestellt, die den ak-
tuellen I/O-Bereichen entsprechen (ohne Profibus-Master keine vorhanden). 

 

Im Monitor für Parametrierung/Konfigurierung können außerdem die Parametrier- und Konfigu-
rierprotokolle des Profibus-Masters dargestellt werden: 

 

Einstellung Bedeutung 

Page 

0…10 

Einstellung des Anzeigebereichs 

Mode Schaltet zwischen grafischer und Zahlenanzeige um. 

OK Eine Menüebene zurück. 

 

 

Im Profibus-Monitor ist die selbsttätige Rückkehr in die Betriebsanzeige  außer Kraft 
gesetzt, um auch längere Beobachtungen zu ermöglichen. 

 

  



LSS MasterGate 

 
LSS 47 

 

 

 

Einstellen der Stimmungsspeicher – Cue mem 

Das LSS MasterGate hat 32 interne Speicherplätze, in denen Lichtstimmungen und auch Daten mit 
anderen Formaten abgespeichert werden können. Die Speicherplätze werden über ArtNet, DMX 
und Profibus angesteuert. Gespeicherte Lichtstimmungen können über beispielsweise Digitale Ne-
benpulte ein- und ausgefahren werden.  

 

Einzelne Einstellungsmöglichkeiten im Menü können nur von LSS MasterGate mit angeschlossen 
Bedienfeld genutzt werden.  

 

Ebene 2 Ebene 3 Ebene 4 Einstellungsmöglich-
keiten 

Bedeutung 

Cue 
mem 

Control mode Profibus, DMX-In 8, 
Art-Net 
Alle anderen Einstel-
lungen haben keine Re-
levanz! 

Einstellung des Mediums bzw. Gerätes, über das 
das LSS MasterGate gesteuert wird. 
 

Dim mode tmo Off, 15s, 30s, 1m, 3m, 
5m, 10m 15m, 20m, 
30m, 45m, 1h, 2h, 3h, 
4h, 6h, 8h, 12h, 24h 

Zeit bis die Registeranzeige in die Betriebsanzei-
gezurückkehrt 

View  Aufruf des Monitors Lichtstimmungen 

 

 

Einstellung Bedeutung 

Control  

mode: 

Einstellung des Netzwerks, mit dem das LSS MasterGate angesteuert wird.  

Profibus: Die Stimmungsspeicher wird über Profibus angesteuert. 

DMX-In 8: Die Stimmungsspeicher wird über DMX angesteuert. 

ArtNet: Die Stimmungsspeicher wird über Ethernet angesteuert. 

Store outs: Zeigt an, wie viele Universes  gespeichert werden:  

1…8: es wird nur 1 Universe im Speicher gespeichert (1 variables Universe) 

ALL: es werden die 8 Mergepuffer parallel eingespeichert (8 Universes) 

Merge to 
out: 

Zeigt an, in welchen Mergepuffer ein Speicherplatz gemergt wird, wenn es als Da-
tenquelle definiert ist. Einstellung unter Config→Routing→DMX-Out(x)→CueMem.  

Toggle  

mode: 

Zeigt an, wie viele Lichtstimmungen aus den Speichern eingefahren werden 

Off: 1-aus-32; es kann nur ein Speicher eingefahren sein 

On: 32-aus-32; es können bis zu 32 Speicher eingefahren sein.  
 Die gespeicherten Werte werden dabei gemergt. 

Art-net 
send: 

Diese Anzeige hat im Augenblick keine Bedeutung. 

Cue time: Zeigt die Ein-/Ausblendzeiten in Sekunden beim Abrufen der Speicher an.  

Ist der Wert 0, wird hart ein- und ausgeblendet 
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Einstellung Bedeutung 

Dim time: Ein-/Ausblendzeiten in Sekunden beim Mergen eines Registers in ein anderes.  

Ist der Wert 0, wird hart ein- und ausgeblendet.  

(Nur bei LSS MasterGate SL anwählbar) 

Dim mode 
tmo: 

Zeit bis die Registeranzeige in die Betriebsanzeigezurückkehrt 

Off: Register-Übersicht bleibt eingeblendet 

 

 

Aufrufen des Speichermonitors –  Cue mem → View 

Das LSS MasterGate liefert bei Betrieb des Stimmungsspeichers wichtige Rückmeldungen: 

 

 Nummer des zuletzt abgerufenen Speichers 

 Flags für laufende Prozesse wie Ein/Ausblenden und Dimmen, Änderungen durch Dimmtas-
ten 

 Zustand der 32 Potiwerte der Register (kann z.B. für Balkenanzeigen usw. verwendet wer-
den 

 Zustand des Summenpotis 

 Belegt-Zustand der 32 Register 

 

Neben der grafischen Darstellung der Rückmeldungen können diese auch prozentual oder als zeit-
licher Wert angezeigt werden. 

 

Anzeige Bedeutung 

□ Zeigt ob das Register Daten enthält, es muss mindestens ein einziger Stromkreis 
einen Wert >1 haben. 

L: Letzte abgerufene Stimmung 

Lev Anzeigemodus (Lev=Balkengrafik) 

% Anzeigenmodus (%=Prozentuale Darstellung) 

Time Anzeigenmodus (Time=Darstellung in Sekunde; obere Wert=Einblendzeit, untere 
Wert=Ausblendzeit, über Summenpoti=Dimm-Zeit für Dim Mode) 

Su Summenpoti 

Mode Schaltet zwischen grafischer und Zahlenanzeige um. 
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Betriebseinstellungen im Options-Menü 

Ebene 2 Ebene 3 Ebene 4 Einstellungsmög-
lichkeiten 

Bedeutung 

CPU Info   Anzeige von CPU-Informationen 

Component Infos   Anzeige von Hardware-Daten 

Software Info   Anzeige von Software-Daten inkl. Firmware-
Version 

Display 
Options 

Menu timeout (w/o moni-
tors) 

Off, 15s, 30s, 1m, 
3m, 5m, 10m 15m, 
20m, 30m, 45m, 1h, 
2h, 3h, 4h, 6h, 8h, 
12h, 24h 

Timeout für Verlassen des Menüs bei Nichtein-
gabe und Rückkehr zur Betriebsanzeige. Gilt 
nicht für die Monitoring-Seiten. 

Cue memory page timeout Off, 15s, 30s, 1m, 
3m, 5m, 10m 15m, 
20m, 30m, 45m, 1h, 
2h, 3h, 4h, 6h, 8h, 
12h, 24h 

Für kommende Anwendungen 

Screensaver timeout Off, 15s, 30s, 1m, 
3m, 5m, 10m, 15m, 
20m, 30m, 45m, 1h, 
2h, 3h, 4h, 6h, 8h, 
12h, 24h 

Timeout für Backlight-Abschaltung des Displays. 
Außer für Vorführungen, Messen usw. sollte die-
se immer aktiviert werden, um das LED-Backlight 
des Displays zu schonen. 

Screensaver LEDs On, Off Einstellung ob Front-LEDs mit dem Display abge-
schaltet werden 

Screensaver Events On, Off Einstellung, ob Display (und Betriebs-LEDs) durch 
Änderungen an den Anschlüssen "aufwachen" 
sollen 

Remote programming On, Off Schaltet den Zugriff von LSS ConfigCore auf das 
LSS MasterGate frei 

Fan control Off, Silent, LoNoise, 
Normal, Cool, Full 
On 

Einstellungen für den Gehäuselüfter 

Security Password   Festlegung eines Zugangspasswortes 

Restore 
Settings 

    Speichern und Laden von bis zu 100 eigenen Ge-
räteeinstellungen. Laden von Werkseinstellun-
gen. 

Watch-
dog re-
set 
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Options → CPU Info  

Hier werden Informationen zur Rechner-Zentraleinheit (CPU), die Versionen von Hauptplatine und 
BIOS sowie die Größe des Flash-Speichers, der als Harddisk dient, angezeigt: 

 

Auswahl Bedeutung 

Counter Aufruf des Menüs zur Anzeige der Boot- und Fehlerzähler. 

OK Eine Menüebene zurück. 

 

Options → CPU Info → Counter  

Hier werden die internen Betriebsspannungen, Temperaturen sowie verschiedene Zählerstände 
angezeigt. Die Zähler können auf 0 gesetzt werden, um Ereignisse ab einem bestimmten Zeitpunkt 
zu zählen: 

 

Wert Bedeutung 

Date/Time Anzeige der aktuellen Systemzeit 

+5V Betriebsspannung des LSS MasterGate  

Bat Spannung der internen Pufferbatterie  

 

 
Ist die Spannung unter 2,5V, ersetzen Sie die Batterie! 

 

CPU Temperatur der CPU 

Brd Temperatur des Mainboards 

Running time Betriebsstundenzähler; kann angewählt und auf 0 gesetzt werden. 

Power on starts Bootvorgänge; kann angewählt und auf 0 gesetzt werden. 

Init Setzt alle Zähler auf die intern im EEPROM mitgezählten Originalwerte. 

Ok Eine Menüebene zurück. 

 

Options → Component Info  

Zeigt Informationen zu den Firmware-Versionen der internen Komponenten an.  

 

Options → Software Info 

Hier werden Informationen zur Firmware-Version, Betriebssystem sowie Programmgröße und 
freiem Speicher angezeigt. Außerdem werden die über Art-Net programmierbaren langen und 
kurzen Gerätenamen angezeigt. 
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Options → Display Options  

Ebene 2 Ebene 3 Ebene 4 Einstellungsmöglichkeiten Bedeutung 

Display 
Options 

Menu timeout (w/o 
monitors) 

Off, 15s, 30s, 1m, 3m, 5m, 10m 
15m, 20m, 30m, 45m, 1h, 2h, 
3h, 4h, 6h, 8h, 12h, 24h 

Timeout für Verlassen des Menüs bei Nicht-
eingabe und Rückkehr zur Betriebsanzeige. 
Gilt nicht für die Monitoring-Seiten. 

Cue memory page 
timeout 

Off, 15s, 30s, 1m, 3m, 5m, 10m 
15m, 20m, 30m, 45m, 1h, 2h, 
3h, 4h, 6h, 8h, 12h, 24h 

Für kommende Anwendungen 

Screensaver timeout Off, 15s, 30s, 1m, 3m, 5m, 
10m, 15m, 20m, 30m, 45m, 1h, 
2h, 3h, 4h, 6h, 8h, 12h, 24h 

Timeout für Backlight-Abschaltung des Dis-
plays. Außer für Vorführungen, Messen usw. 
sollte diese immer aktiviert werden, um das 
LED-Backlight des Displays zu schonen. 

Screensaver LEDs On, Off Einstellung ob Front-LEDs mit dem Display 
abgeschaltet werden 

Screensaver Events On, Off Einstellung, ob Display (und Betriebs-LEDs) 
durch Änderungen an den Anschlüssen 
"aufwachen" sollen 

Remote programming On, Off Schaltet den Zugriff von LSS ConfigCore auf 
das LSS MasterGate frei 

Fan control Off, Silent, LoNoise, Normal, 
Cool, Full On 

Einstellungen für den Gehäuselüfter 

 

Einstellung Bedeutung 

Menu timeout 
(w/o monitors) 

Timeout für Verlassen des Menüs bei Nichteingabe und Rückkehr zur Be-
triebsanzeige. 

Gilt nicht für die Monitoring-Seiten. 

Screensaver 
timeout 

Timeout für Backlight-Abschaltung des Displays 

Außer für Vorführungen, Messen usw. sollte diese immer aktiviert werden, 
um das LED-Backlight des Displays zu schonen. 

Screensaver 
LEDs 

Einstellung ob Betriebs-LEDs mit dem Display abgeschaltet werden 

Off: Die Betriebs-LEDs werden nicht abgeschaltet 

On: Die Betriebs-LEDs werden mitabgeschaltet 

Screensaver 
events 

Einstellung, ob Display (und Betriebs-LEDs) durch Änderungen an den An-
schlüssen "aufwachen" sollen. 

Off: Statusänderungen wirken sich nicht auf Bildschirmschoner aus 

On: Statusänderungen an DMX-In/Out oder Ethernet schalten den  
 Bildschirmschoner aus und zeigen die jeweilige Statusseite an 

Remote pro-
gramming 

On: Das LSS MasterGate ist per Art-Net programmierbar 

Off: Das LSS MasterGate ist nicht per Art-Net programmierbar 

Art-Net ist die Grundlage für ConfigCore. Ist diese Funktion deaktiviert, kann 
das Gerät nicht über die Konfigurationssoftware eingestellt werden. 

Fan Control Diese Einstellungen haben für das LSS MasterGate keine Bedeutung. 
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Options → Security 

Hier können Sie das Passwort ändert oder die Passwortabfrage abschalten: 

 

Das aktuelle Passwort wird immer als „******“ angezeigt, auch wenn es kürzer als 6 Zeichen ist. 
Durch Drücken auf „Clear“ wird das Passwort gelöscht (Anzeige „______“). Wenn dieser Zustand 
mit „Ok“ gespeichert wird, erfolgen keine Passwortabfragen mehr. 

 

Durch Anwahl einer Stelle und Drücken sowie Drehen des Encoders können Buchstaben eingege-
ben und durch erneutes Drücken übernommen werden. Es gibt nur Kleinbuchstaben, „_“ ent-
spricht einem Leerzeichen. „Ok“ speichert dann das neue Passwort ab. 

 

Auswahl Bedeutung 

****** Passworteingabe 

Clear Passwort löschen. 

Ok Einstellungen speichern und eine Menüebene zurück. 

Cancel Abbruch und eine Menüebene zurück. 

 

 

Obwohl das System eine große Sicherheit bietet, kann eine absolute Sicherheit nicht 
gewährleistet werden! Treffen Sie geeignete Maßnahmen vor Ort, um einen nichtau-
torisierten Zugriff zu verhindern! 
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Options → Restore Settings  

Im LSS MasterGate portable können Wiederherstellungspunkte definiert werden. Dadurch können 
neben den Werkseinstellungen auch eigene Einstellungen gespeichert und zu einem späteren 
Zeitpunkt wieder geladen werden. Es können dabei bis zu 100 eigene Einstellungen gespeichert 
und frei wählbar geladen werden. 

 

 
Beachten Sie die angezeigten Warnungen! 

 

Ebene 2 Ebene 3 Einstellungsmög-
lichkeiten 

Bedeutung 

Restore 
Settings 

Factory defaults 1…100  

User Saved 1…100  

 

 

Einstellung Bedeutung 

Restore to Auswahl der Factory defaults (Werkseinstellungen gemäß letzten Firmware-
Updates) oder einen Wiederherstellungspunktes nach Datum und Zeit 

User saved Anzahl der gespeicherten Wiederherstellungspunkte 

Delete Löscht gespeicherte Wiederherstellungspunkte (diese müssen unter Restore to 
aufgerufen sein) 

Save Speichert Wiederherstellungspunkte mit Datum und Zeit 

 

 

Options → Watchdog reset 

Unter diesem Menüpunkt wird das Gerät hardwaremäßig rückgesetzt und damit der Watchdog 
getestet. 
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Konfiguration des MasterGate mit 
ConfigCore 
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Konfigurationssoftware ConfigCore 

Die Konfiguration der LSS MasterGate kann auch über die Konfigurationssoftware LSS ConfigCore 
erfolgen. ConfigCore steht als kostenlose Software auf der Homepage der LSS als Download zur 
Verfügung. Die Grundlagen der Software werden im Handbuch „ConfigCore“ erläutert. Das Hand-
buch LSS MasterGate setzt voraus, dass diese Grundlagen beherrscht werden.  

 

Das LSS MasterGate wird grundsätzlich in zwei Menüs konfiguriert. Die Definition der DMX-
Anschlüsse und die Einstellungen zum Mergen (Routing) von Daten werden in dem Menü „Port-
konfiguration“ vorgenommen, alle anderen im Menü „Erweiterte LSS Device Features“. 

 

 

Erweiterte LSS Device Features 

Einleitung 

Das Untermenü "Erweiterte LSS Device Features" beinhaltet die Einstellungsmöglichkeiten für: 

 Ethernet,  

 RDM, 

 Profibus,  

 Stimmungsspeicher und  

 Optionen des Geräts.  
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Einstellen aller Ethernet-Parameter 

 

 
 
 

Auswahl Bedeutung 

Empfangsprotokoll Einstellung des Licht-Netzwerkprotokolls für Empfang: 

Art-Net AVAB/IPX AVAB/UDP ShowNet sACN 

Sendeprotokoll Einstellung des Licht-Netzwerkprotokolls für Senden: 

Art-Net AVAB/IPX AVAB/UDP ShowNet sACN 

Licht Timeout Einstellung des Timeouts beim Ausfall der empfangenen Daten 

0…999 s  (0 = letztes Protokoll halten) 

Netzwerk Senderate Einstellung der Mindest-Senderate für Lichtnetzwerkprotokolle, wenn sich 
keine Werte ändern.  

20ms, 25ms, 30ms, 40ms, 50ms, 0,1s, 0,2s, 0,5s, 1s, 2s, 3s, 4s 

IP Mode Bezug der IP-Adresse: 

Manuell: freie Einstellmöglichkeit 

Art-Net 2: Art-Net-Adresse im 2er Netz 

Art-Net 10: Art-Net-Adresse im 10er Netz 

DHCP:  IP-Adresse wird von einem DHCP-Server bezogen. Es muss 
  ein DHCP-Server im Netzwerk vorhanden sein! 

IP Adresse wenn Manual: freie Einstellung der IP-Adresse 

sonst:  Schaumodus für die bezogene oder generierte IP-Adresse 
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Auswahl Bedeutung 

Subnetmaske wenn Manual: freie Einstellung der Subnetmaske 

sonst:  Schaumodus für die bezogene oder generierte   
  Subnetmaske 

Gateway Einstellung der Gateway-Adresse 

Richtungssteuerung Nur sichtbar, wenn “Einstellung Übertragungsmedium“ manuell eingestellt. 

Full:  voller Duplex 

Half:  halber Duplex 

Netzwerk-
Geschwindigkeit 

Nur sichtbar, wenn “Einstellung Übertragungsmedium“ manuell eingestellt. 

10 Mbit/s 

100 Mbit/s 

SLP Schaltet SLP-Netzwerkprotokoll ein. 

RDM-Net Schaltet RDM-Net ein oder aus. 

Sendechecksumme On:  Berechnung der Checksumme eingeschaltet 

Off:  Berechnung der Checksumme ausgeschaltet 

Empfangscheck-
summe 

On:  Berechnung der Checksumme eingeschaltet 

Off:  Berechnung der Checksumme ausgeschaltet 

Einstellung Übertra-
gungsmedium 

Auto- 

negotiation: automatische Geschwindigkeit und Duplexmodus  

Manuell: manuell definierte Geschwindigkeit und Duplexmodus 
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Globale RDM-Einstellungen 

In diesem Untermenü können grundlegende Einstellungen für das Remote Device Management 
festgelegt werden. Diese Einstellungen gelten für alle RDM-Kanäle 

 

 
 

Auswahl Bedeutung 

RDM Discovery-
Intervall 

Stellt die Intervallzeiten der der inkrementellen Discovery in Sekunden ein. 

RDM Optionen Incremental 
discovery 

Mit dieser Funktion ist RDM-Discovery immer aktiv! Es 
werden immer Daten gesammelt und Identifizierungsan-
fragen für neue Geräte in die Universen gesendet.  

On: Incremental discovery ist immer aktiv. 

Off: Incremental discovery ist nicht aktiv. 

Background 
discovery 

Mit dieser Funktion arbeitet die inkrementelle Discovery im 
Hintergrund. Dadurch wird das DMX-Signal weniger ge-
stört. Allerdings kann es sein, dass sich die Intervallzeit weit 
über oben eingestellte hinaus verlängert! 

On: Background discovery ist aktiv. 

Off: Background discovery ist nicht aktiv. 
 

Terminierung Port 6 On: Schaltet die Terminierung für Port 7 ein 

Off: Schaltet die Terminierung für Port 7 aus 
 

Terminierung Port 7 On: Schaltet die Terminierung für Port 8 ein 

Off: Schaltet die Terminierung für Port 8 aus 
 

Static Filter Für kommende Anwendungen. 

Filter Ports Für kommende Anwendungen. 
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Optionen 

Im Punkt Optionen werden zuerst vier Informationsseiten über die Hardware, Software, Betriebs-
zähler und über das Netzwerk angezeigt. Diese können als Überwachungsmonitore eingesetzt 
werden. Darauffolgend können grundlegende Geräteeinstellungen festgelegt werden. 

 

 

 

Auswahl Bedeutung 

Menü-Timeout Zeit bis Rückkehr vom Menü zur Betriebsanzeige im Gerätedisplay. 

Screensaver-
Timeout 

Timeout für Backlight-Abschaltung des Displays  

(OFF, 15s, 30s, 1m, 3m, 5m, 10m, 15m, 20m, 30m, 45m, 1h, 2h, 3h, 4h, 6h, 
8h, 12h, 24h)  

Screensaver Events On: Statusänderungen an DMX-In/Out oder Ethernet schalten Bild-
 schirmschoner aus und zeigen die jeweilige Statusseite an 

Off: Statusänderungen wirken sich nicht auf Bildschirmschoner aus 

Front-LED Einstellung ob Betriebs-LEDs mit dem Display abgeschaltet werden 

Off: Die Betriebs-LEDs werden nicht abgeschaltet 

On: Die Betriebs-LEDs werden mitabgeschaltet 

Default Bildschirm Diese Einstellung hat beim LSS MasterGate keine Bedeutung. 

Kennwort Hauptmenü-Pin 

0…30000s (0 = aus) 

Sende sACN Draft Auswahl des unterstützen sACN-Protokolls  

On:  LSS MasterGate arbeitet mit sACN nach Standard E1.31 R0 Draft 

Off:  LSS MasterGate arbeitet mit sACN nach Standard E1.31 2009 
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Auswahl Bedeutung 

Sende Art-Net als 
Broadcast 

Erlaubt die Kommunikation mit ADB-Anlagen. 

Art-Net 3 Netzwerk Erlaubt einen ArtNet3 IP-Adressbereich 

Lüftersteuerung Diese Einstellung hat beim LSS MasterGate keine Bedeutung. 

Debugmodus Diese Einstellung hat beim LSS MasterGate keine Bedeutung. 

 

Profibus 

Hier werden die beim LSS MasterGate möglichen Profibus-Einstellungen vorgenommen. Profibus-
DP ist ein Feldbussystem mit Master/Slave-Einstellungen. Das bedeutet, dass das LSS MasterGate 
ist in den Profibus als Slave eingebunden ist. Die eigentliche Konfiguration und Parametrierung 
wird am Master, der SPS, vorgenommen. 

 

 

 

Auswahl Bedeutung 

Profibus Adr. Einstellung der Profibus-Slaveadresse 

DP Buffer Modus 1 Von der SPS kommende Profibus-Daten werden in vordefinierte 
Subnets/Universes ausgegeben. Die Auswahl der Subnets / Univer-
ses wird in der SPS vorgenommen. 

8 Von der SPS kommende Profibus-Daten werden in alle Subnets/ 
Universes ausgegeben 
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Stimmungsspeicher  

In diesem Menü können Einstellungen für den Stimmungsspeicher vorgenommen werden. Dabei 
sind aber immer die Einstellungen durch den Profibus-Master (SPS) zu beachten. Deshalb darf die-
ses Menü von speziell geschultem Personal genutzt werden und die Einstellungen werden hier 
nicht näher erläutert. 
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Portkonfiguration 

In diesem Menü werden die DMX-Anschlüsse  und die Parameter für alle DMX Aus- und Eingänge 
festgelegt. 

 

 

 

 

Definition der DMX-Anschlüsse und Mergen von Daten 

Die DMX- Anschlüsse 1 bis 8 können einzeln und völlig frei als physikalischer und virtueller Ein- o-
der Ausgang definiert werden. Zusätzlich können sie auch abgeschaltet werden. Die Einstellung 
wird im Untermenü „Portkonfiguration“ vorgenommen. Jeder DMX-Anschluss besitzt einen eige-
nen Mergepuffer, in dem Daten gemergt und von dort ausgesendet werden.  

 

Auswahl Bedeutung 

Nicht vorhanden Der DMX-Anschluss wird vollständig abgeschaltet. 

Physikalischer IN Der DMX-Anschluss ist als Eingang definiert. 

Physikalischer OUT Der DMX-Anschluss ist als Ausgang definiert. 

Virtueller Out Der physikalische Anschluss ist deaktiviert, der Mergepuffer ist aktiv. 

Virtueller In Der physikalische Anschluss ist deaktiviert, der Mergepuffer ist aktiv. 
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Einstellungen für physikalische DMX-Anschlüsse 

DMX-Anschluss als physikalischer IN 

Ist der DMX-Anschluss als physikalischer Eingang definiert, kann nur folgende Einstellung vorge-
nommen werden: 

 

Auswahl Bedeutung 

DMX Timeout In Empfangs-Timeout bei Empfangs-Ausfall 

1…10s nach Ablauf wird DMX-Anschluss als Merge-Quelle abgeschaltet 

 

DMX-Anschluss als physikalischer OUT 

Ist der DMX-Anschluss als physikalischer Ausgang definiert, werden im zum Anschluss gehörenden 
Mergepuffer die Daten aus verschiedenen Quellen gemergt und über den Anschluss ausgegeben. 
Folgende Einstellungen sind möglich: 

 

Auswahl Bedeutung 

DMX Timeout Out Timeout wenn der Mergepuffer/DMX-Out keine Daten mehr erhält. 

0s: Hold, der letzte Werte wird unverändert weiter gesendet 

1…10s: nach Ablauf der Zeit wird Mergepuffer/DMX-Out abgeschaltet 
 

Out Modus Sende-Timeout wenn der Mergepuffer/DMX-Out keine Daten mehr er-
hält 
Hold: Der letzte Wert wird unverändert weiter gesendet. 
Backup: Nach Ablauf der eingestellten Zeit wird der Mergepuffer/DMX-

Out abgeschaltet. 
 

In Modus Einstellung für das Senden ins Ethernet. Diese Einstellungen entsprechen 
dem ODM Config→Routing→Network Out 

Off: Der Inhalt des Mergepuffers wird nicht ins Ethernet 
gesendet. Der Inhalt steht aber anderen Medien zur 
Verfügung. 

DMX-Out-Buffer: Der Inhalt des Mergepuffers wird ins Ethernet ge-
sendet. 

DMX-In direct: Ist der DMX-Anschluss als DMX-In definiert, werden 
die eingehenden DMX-Signale direkt ohne den In-
halt des Mergepuffers ins Ethernet gesendet. 

 

Merge Modus Auswahl der Datenquellen, die im Puffer gemergt und über den Anschluss 
gesendet werden. 

Port 1 bis 8, Profibus, CueMem, Ethernetdatenquelle 0, 1, 2 und 3 
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Auswahl Bedeutung 

RX Subnet Einstellung des Subnets, aus dem Daten empfangen werden (abhängig vom 
gewählten Licht-Netzwerkprotokoll). 

RX Universe Einstellung des Universe, aus dem Daten empfangen werden (abhängig 
vom gewählten Licht-Netzwerkprotokoll) 

TX Universe Einstellung des Universe, in das Daten gesendet werden (abhängig vom 
gewählten Licht-Netzwerkprotokoll) 

TX Priority Einstellung der Sende-Priorität (lichtprotokollabhängig) 

DMX Startcode Legt den DMX-Startcode fest. 

Sendeprotokoll-
Länge 

Legt die Länge des Sendeprotokolls fest. 

Breaklänge Einstellung der Breaklänge von 90…999 µs 

MAB Länge Einstellung der Mark-after-Break-Länge von 20…999 µs 

MBB Länge Einstellung der Mark-before-Break-Länge von 20…999 µs 

Protokollstretching Einstellung der Mark-before-Slot-Länge von 20…999 µs 

RDM Schaltet die RDM-Funktion für das ausgehende DMX-Universe ein. 

RDM Discovery Schaltet die RDM-Discovery ein oder aus.  

 
 

Einstellungen für virtuelle Anschlüsse 

DMX-Anschluss als virtueller IN 
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DMX-Anschluss als virtueller OUT 

Wird der DMX-Anschluss als virtueller Ausgang definiert, ist der physikalische Anschluss deakti-
viert. Der Mergepuffer steht hingegen als Speicher zum Mergen von Daten weiterhin zur Verfü-
gung. Gemergte Daten werden aus dem Puffer ins Ethernet ausgesandt.  

 

Auswahl Bedeutung 

DMX Timeout Timeout wenn der Mergepuffer/DMX-Out keine Daten mehr erhält. 

0s: Hold, der letzte Werte wird unverändert weiter gesendet 

1…10s: nach Ablauf der Zeit wird Mergepuffer/DMX-Out abgeschaltet 
 

RX Universe Einstellung des Universe, aus dem Daten empfangen werden (abhängig 
vom gewählten Licht-Netzwerkprotokoll) 

RX Subnet Einstellung des Subnets, aus dem Daten empfangen werden (abhängig 
vom gewählten Licht-Netzwerkprotokoll) 

RX Priority Einstellung der Priorität, aus dem Daten empfangen werden (abhängig 
vom gewählten Licht-Netzwerkprotokoll) 

Merge Modus Auswahl der Datenquellen, die im Puffer gemergt und über den Anschluss 
gesendet werden. 

Port 1 bis 13, Ethernetdatenquelle 0, 1 und 2 

TX Universe Einstellung des Universe, in das Daten gesendet werden (abhängig vom 
gewählten Licht-Netzwerkprotokoll) 

TX Priority Einstellung der Priority, in das Daten gesendet werden (abhängig vom ge-
wählten Licht-Netzwerkprotokoll) 

TX Subnet Einstellung des Subnets, in das Daten gesendet werden (abhängig vom 
gewählten Licht-Netzwerkprotokoll) 
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Netzsicherung wechseln 

Sicherungstyp:  Schmelzsicherung 1,6A T 

 

1. Trennen Sie das Gerät von der Spannungsversorgung und jeglichen anderen Verbindungen. 

2. Entriegeln Sie den Sicherungshalter oberhalb der Kaltgerätebuchse. 

3. Entnehmen Sie den Sicherungshalter. 

4. Entnehmen Sie die defekte Sicherung. 

5. Ersetzen Sie diese durch eine intakte Sicherung. 

6. Schieben Sie den Sicherungshalter wieder ein und vergewissern Sie sich, dass der Halter 
einrastet. 

 

Überbrücken Sie niemals eine Sicherung! 

Verwenden Sie nur den oben angegebenen Sicherungstyp! 

Stellen Sie sicher, dass der Sicherungshalter fest eingerastet ist! 

 

Kontaktaufnahme 

Falls Probleme beim Betrieb des LSS LSS MasterGate auftreten, sollten die Beschreibungen und 
Hinweise in diesem Handbuch zur Fehleranalyse und Fehlerbehebung weiterhelfen. Sollte dies 
nicht der Fall und es werden weiterführende Hilfestellungen benötigt, wenden Sie sich an den LSS 
Service. 

 

Bei der Kontaktaufnahme sollten folgende Informationen vorliegen: 

 

- Ort der Gesamtanlage und Position des LSS MasterGate in der Anlage (mit Angabe von Se-
riennummer/MAC-Adresse/IP-Adresse) 

- Ausführliche Fehlerbeschreibung 
- Ausführliche Beschreibung der bisher erfolgten Fehlersuche 
- Beschreibung zusammenhängender System- oder Geräteprobleme 

 

Kontaktadresse: 

LSS GmbH 

Licht-, Steuer- und Schaltanlagenbau GmbH 

Am Eichenberg 1 

D-04600 Altenburg 

Tel.: +49 3447 83 55 00 

Fax: +49 3447 86 17 79 

mail@lss-lighting.de  
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Anhang A 

Besonderheiten der Netzwerkprotokolle 

Die Netzwerkeinstellungen (IP-Mode, IP-Adresse, Netzwerkmaske) des LSS MasterGate  wirken 
sich bei den verschiedenen Lichtprotokollen unterschiedlich aus: 

 

Licht-
Protokoll 

IP-Besonderheiten 

Art-Net IP-Mode, IP-Adresse und Netzmaske wirken sich direkt auf Art-Net aus. Aus Kompa-
tibilitätsgründen sollte immer der automatische IP-Mode „Art-Net2“ verwendet 
werden. 

AVAB/IPX IP-Mode, IP-Adresse und Netzmaske wirken sich überhaupt nicht auf AVAB/IPX aus, 
da dieses ein Novell-Protokoll ist. 

Der LSS MasterGate kann aber trotzdem remote über Art-Net konfiguriert werden, 
dafür sind IP-Mode, IP-Adresse und Netzmaske relevant  -zur Kompatibilität auch 
hier am besten „Art-Net2“ verwenden. 

AVAB/UDP IP-Mode, IP-Adresse und Netzmaske wirken nicht auf AVAB/UDP aus, da AVAB/UDP 
mit  Broadcasts arbeitet. 

So kann man auch hier am besten die Defaulteinstellung „Art-Net2“ verwenden und 
damit auch hier immer den LSS MasterGate über Art-Net remote konfigurieren. 

ShowNet IP-Mode, IP-Adresse und Netzmaske wirken sich auf ShowNet aus.  

Häufig wird 192.168.0.x oder 192.168.1.x verwendet. Die Netzwerkmaske sollte 
255.255.255.0 sein.  

Um dies einstellen zu können, muss der IP-Mode „Manuell“ sein (oder DHCP, falls es 
einen entsprechenden DHCP-Server im Netz gibt). 

Der LSS MasterGate kann trotzdem remote mittels ConfigCore über Art-Net konfi-
guriert werden. 

sACN IP-Mode, IP-Adresse und Netzmaske wirken sich nicht auf ACN aus, da ACN ein Mul-
ticast-Protokoll mit der IP 239.255.x.y ist. Dieses wird unabhängig empfangen. 

So kann man auch hier am besten die Defaulteinstellung „Art-Net2“ verwenden und 
damit auch hier immer den LSS MasterGate über Art-Net remote konfigurieren. 
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Die einstellbaren Parameter Subnet und Universe unterscheiden sich wie folgt: 

 

Protokoll Universe Subnet Besonderheiten 

Art-Net 0…15 0…15 Der LSS MasterGate kann auf jedem einzelnen DMX-Port mit 
verschiedenem Subnet und Universe arbeiten. 

Dies ist mit ConfigCore, nicht aber mit Fremdsoftware, einzeln 
einstellbar, nur mit dem LSS-Softwaretool. 

AVAB/IPX 1…12 0…9 Beim Senden ist die Priorität von 0...200 einstellbar. 

AVAB/UDP 1…32 0…9 Beim Senden ist die Priorität von 0...200 einstellbar. 

ShowNet 1…36 nicht 
vorhan-
den 

Bei ShowNet gibt es eigentlich keine Universes,  alle Dimmer-
daten werden in einem 18432 Kreise großen Feld dargestellt. 
In älteren Anlagen (5xx) konnte man dies auch konfigurieren. 

Trotzdem hat sich in der Praxis die Einteilung in Vielfache von 
512 durchgesetzt (wegen DMX). 

Der LSS MasterGate verhält sich beim Einstellen des Universe 
wie neuere Anlagen von Strand Lighting: hier stellt man nur 
noch Vielfache von 512 ein, „XDMX Nr.“ genannt. „Krumme“ 
Adressen sind nicht möglich. Die realen Kreisnummern von 
1…18432 werden im Routing zusätzlich angezeigt.  

sACN 1… 65279 nicht 
vorhan-
den 

Beim Senden ist die Priorität von 0...200 einstellbar. 

 

Wahl des Lichtprotokolls 

Bietet eine Anlage mehrere Lichtprotokolle zur Auswahl, so sollte vom Standpunkt der Netzwerk-
belastung die Rangfolge sein: 

1. sACN 

2. Art-Net 

3. ShowNet 

4. AVAB/UDP 

5. AVAB/IPX 
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Konfiguration für die verschiedenen Lichtprotokolle 

sACN 

Das Licht-Netzwerkprotokoll sACN ist das werksseitig voreingestellte Standardprotokoll. Beim La-
den der Default-Werte wird dieses Licht-Netzwerkprotokoll aktiviert und folgende Parameter ein-
gestellt:  

 

Empfangs-Netzwerkprotokoll: sACN 

Empfangstimeout:   3s 

Sende-Netzwerkprotokoll:  sACN 

Senderate:    0,5s 

 

Da der LSS MasterGate in den Default-Einstellungen als DMX-Booster läuft, sind folgende Routing-
Parameter voreingestellt: 

 

DMX-Anschlüsse 1 bis 12:  Out 

Sendepriorität:   0 (entspricht 100) 

DMX-Anschluss 13:   In 

Ethernet als Mergequelle:  deaktiviert 

 

Wird der LSS MasterGate mit dem Netzwerkprotokoll sACN eingesetzt, so kann die Netzwerkbelas-
tung für ihn und andere Netzwerkteilnehmer sehr effektiv gesenkt werden, wenn man manage-
mentbare Switche einsetzt, die das sogenannte "IGMP Snooping" beherrschen. 

 

Derartige Switche erkennen, welche Universes die Geräte an jedem Switch-Port benötigen und 
schalten dann nur diese Universes zu den jeweiligen Geräten durch. 

 

Per Default hört der LSS MasterGate auch auf Art-Net-Softwaretools und andere Anlagen. 

 

Art-Net 

Schalten Sie das Empfang-Netzwerkprotokolls AVAB/IPX ein. Der Empfangstimeout ist 8s, die Sen-
derate ist 1s. 

Das Default-Subnet ist 0 und die Universes 0…12 für die zwölf DMX-Anschlüsse (egal ob diese In 
oder Out sind). Andere Subnets und/oder Universes stellen Sie unter Config→Routing→Port1…12 
ein. Dort schalten Sie die Ports auch einzeln ein oder aus. 

 

Per Default hört der LSS MasterGate auch auf Art-Net-Softwaretools und andere Anlagen. 
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ShowNet 

Schalten Sie das Empfangs-Netzwerkprotokoll ShowNet ein. Empfangstimeout ist 8s. 

 

Schalten Sie das Sende-Netzwerkprotokoll ShowNet ein. Stellen Sie die Senderate auf 4s. 

 

Die Default-Universes (XDMX) sind 1…12 für die zwölf DMX-Anschlüsse (egal ob diese In oder Out 
sind). 

Andere Subnets und/oder Universes stellen Sie unter Config→Routing→Port1…12 ein. Dort schal-
ten Sie die Ports auch einzeln ein oder aus. 

Per Default hört der LSS MasterGate zwar auf Art-Net-Softwaretools, aber nicht jedes kommt mit 
den 192.168er IP-Adressbereichen klar. 

 

AVAB/IPX 

Schalten Sie das Empfang-Netzwerkprotokolls AVAB/IPX ein. Stellen Sie den Empfangstimeout auf 
3s. 

 

Schalten Sie das Sende-Netzwerkprotokolls AVAB/IPX ein. Stellen Sie die Senderate auf 0,5s. 

 

Das Default-Subnet ist 0 und die Universes 1…12 für die zwölf DMX-Anschlüsse (egal ob diese In 
oder Out sind). Andere Subnets und/oder Universes stellen Sie unter Config→Routing→Port1…12 
ein. Dort schalten Sie die Ports auch einzeln ein oder aus. 

Per Default hört der LSS MasterGate auch auf Art-Net-Softwaretools und andere Anlagen. 

 

AVAB/UDP 

Schalten Sie das Empfang-Netzwerkprotokolls AVAB/UDP ein. Stellen Sie den Empfangstimeout 
auf 3s. 

 

Schalten Sie das Sende-Netzwerkprotokolls AVAB/UDP ein. Stellen Sie die Senderate auf 0,5s. 

 

Das Default-Subnet ist 0 und die Universes 1…12 für die zwölf DMX-Anschlüsse (egal ob diese In 
oder Out sind). Die Default-Sendepriorität ist 0 (entspricht höchster, immer mergen). Andere Sub-
nets und/oder Universes stellen Sie unter Config→Routing→Port1…12 ein. Dort schalten Sie die 
Ports auch einzeln ein oder aus. 

 

Per Default hört der LSS MasterGate auch auf Art-Net-Softwaretools und andere Anlagen. 
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Anhang B 

Technische Daten 

Allgemeine technische Daten 

 
Bauart: Fertiggerät 
Abmessungen BxHxT: 483 x 89 x 180mm (19‘‘ 2HE) 
Gewicht: 2000g 
Lieferumfang: Gerät, Kaltgeräteanschlusskabel 
  
EMV-Standards: EN 55022, class B, FCC part 15, level B 
RoHS Konform 
  
Spannungsversorgung: 100 – 240V AC, 50/60Hz 
Leistungsaufnahme: 15W (typisch) 
Verlustleistung: 15W 
  
Betriebstemperatur: 0°C – 40°C 
 

Schnittstellen 

 

DMX/RDM Wahlweise: 

 8x RJ45, ESTA-Belegung 

 8x 5polig XLR 
Ports können einzeln als Ein- oder Ausgang in der Konfiguration defi-
niert werden. Die Ports sind immer durch Optokoppler potentialge-
trennt. 

Ethernet: 1x RJ-45, IEEE-Belegung für 100BaseTx 
Profibus: 1x PROFIBUS-DP (EN 50170), Sub-D Buchse 9-polig 

Potentialtrennung durch Optokoppler 
DMX-Filter (optional) 1x Pfostenstecker mit Verriegelung 10-polig 
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Netzwerk 

DMX 

Allgemein 
DMX-Protokoll: DMX-512  
Standards: USITT 1990, DIN 56930-2, ANSI E1.11 
Baudrate: 250 kbps 
Ausgänge: einzeln potentialgetrennt 
 (ISOLATED nach ANSI E1.11 A1) 
Potentialtrennung:    Optokoppler 
Isolationsspannung:    1000V DC 

Isolationswiderstand:    109  
EMV: Filterbeschaltung nach Stand der Technik an allen Ein- 

und Ausgängen 
Terminierung: werksseitig intern 
 

Empfang 

Startcode: =0    Lichtprotokoll (in Display ●) 

 <>0  kein Lichtprotokoll, RDM (in Display  R) 
minimale Protokolllänge: nur Startcode 
maximale Protokolllänge: Startcode + 512 Werte 
 (Werte über 512 gehen verloren) 

minimale Durchlaufverzögerung: 44 s 
maximale Durchlaufverzögerung: 22,5ms 
Empfangstimeout: 1…10s 
max. Abstand zwischen 2 Protokollen: 1…10s 

Minimale erkannte Breaklänge: 48 s 
Maximal zulässige Breaklänge: 1,95 s 
 

Senden 
Startcode: 0 
Protokolllänge: Startcode + 512 Werte 
Minimale Protokollzeit: 22,4ms 
Breaklänge: 90…999 µs (einstellbar) 
Mark After Break: 20…999 µs (einstellbar) 
Zusätzliche Pause nach Startcode: 25 µs 
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Ethernet 

Allgemeines 
Schnittstelle: 10/100 BaseT (IEEE 802.3u, 802.3x) 
Geschwindigkeit: 10 MBit/s, 100MBit/s; Autonegotiation 
Duplex-Mode: halb, voll; Autonegotiation 
 Auto-MDI/MDIX 
Anzeige: Link-LED, Data-LED, Geschwindigkeit und Duplex-Mode 

werden im Display angezeigt 
Lichtprotokolle: Art-Net (ArtisticLicence) 
 AVAB-IPX (AVAB, transtechnik, LDDE,…) 

 AVAB/UDP (transtechnik) 
 ShowNet (Strand Lighting) 

 sACN (ANSI E1.31) 
weitere Netzwerkprotokolle: ARP, IP, IPX, UDP, IGMPv2, TFTP, SLP v2, NetRDM 
 

Empfang 
Maximale Paketrate: >1000/s (bei 1 Lichtframe/Paket) 

Minimale Durchlaufverzögerung: 4 s 
Maximale Durchlaufverzögerung: 22,7 ms 
Max. Abstand zwischen 2 Protokollen: 1...999 s  (Halten per DMX-Out einstellbar) 
 
 

Senden 
Senderate bei Wertänderung: maximal aller 20 ms 
Senderate ohne Wertänderung: 20 ms … 4 s (einstellbar) 
 

Profibus 

Unterstützte Baudraten: 9,6 kBit/s...12 MBit/s 
Stationsadresse: 0...126 
TSDRmin: 11 Bitzeiten 
PNO-Identnummer: 0A99h 
GSD-Datei: verfügbar 
Diagnose: 1 Byte externe Diagnose (parametrierbar) 
Slave-Verhalten: modularer Slave, FREEZE, SYNC, AUTOBD. 
Länge Input-Bereich: max. 244 Byte 
Länge Output-Bereich: max. 244 Byte 
Summe der Input/Output-Bytes: max. 248 Byte 
Länge User-Parametrierung: max. 242 Byte (davon 235 für User) 
Anzahl Module: max. 16 
Byte pro Modul: 1...16, frei variabel, Byte-konsistent 
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Anschlussbelegung 

DMX-Anschlüsse 

5 Pin XLR 

Belegung nach DMX512-Standard 

 

Pin Belegung 

1 Data Ground 

2 Data - 

3 Data + 

4 Spare 

5 Spare  

 

PE kann über die Schirmung geführt werden 

 
 
 

RJ45 

Belegung nach DMX512-Standard 

 

Pin Belegung 

1 Data + 

2 Data - 

3 Spare 

4  

5  

6 Spare 

7 Data Ground 

8 Data Ground 

S Kabelschirm 
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Ethernet 

Der Ethernet-Anschluss unterstützt Power-over-Ethernet nach IEEE 802.3af 

 

Pin Belegung 

1 Rx + 

2 Rx - 

3 Tx + 

4 V + 

5 V + 

6 Tx - 

7 V - 

8 V - 

S Kabelschirm 

 

 

Profibus 

 

Pin Belegung 

1  

2  

3 Data + 

4 RTS 

5 Ground 

6 +5V DC 

7  

8 Data - 

9  

 

Bestellnummer 

 

Modell Anschlüsse Bestellnummer 

LSS MasterGate RJ45 5501 

XLR 5511 

 

 


